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Welcome

About EastWest
EastWest (www.soundsonline.com) has been dedicated to perpetual innovation and un-
compromising quality, setting the industry standard as the most critically acclaimed 
producer of Sample CDs and Virtual (software) Instruments. 

Founder and producer Doug Rogers has over 30 years experience in the audio industry 
and is the recipient of many recording industry awards including “Recording Engineer of 
the Year.” In 2005, “The Art of Digital Music” named him one of “56 Visionary Artists & 
Insiders” in the book of the same name. In 1988, he founded EastWest, the most criti-
cally acclaimed sound developer in the world, and recipient of over 50 industry awards, 
more than any other sound developer. His uncompromising approach to quality, and 
innovative ideas have enabled EastWest to lead the sound-ware business for 20 years.

In 1997 Rogers partnered with producer/composer Nick Phoenix and set up Quantum 
Leap, a wholly owned division of EastWest, to produce high-quality, no-compromise 
sample libraries and virtual instruments. Quantum Leap virtual instruments are mostly 
produced by Nick Phoenix. Some of the larger productions, such as Symphonic Orches-
tra, Symphonic Choirs and Quantum Leap Pianos are co-produced by Doug Rogers and 
Nick Phoenix. As a composer, Phoenix began scoring film trailers and television com-
mercials in 1994. To date, he has either scored or licensed music for the ad campaigns 
of over 1000 major motion pictures including Terminator 3, Lord of the Rings Return of 
the King, Harry Potter 5, Wall-E, Star Wars Episode 2, Spiderman 3, Pirates of the Carib-
bean 3, Blood Diamond, Night at the Museum, 300, and The Da Vinci Code. Quantum 
Leap has now firmly established itself as one of the world’s top producers of high-end 
sample libraries and virtual instruments. 

www.soundsonline.com
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Producer: Doug Rogers
EastWest founder and producer Doug Rogers has used his vision of the sound develop-
ment industry to lead a company that creates products that not only keep pace with 
the  technological advancements of the last 20 years, but push the boundaries of what 
can be achieved with the latest technologies. This vision has earned him, his company, 
and its products numerous award and accolades. Keyboard Magazine awarded East-
West/Quantum Leap Symphonic Orchestra its “Key Buy Award.” And Rene Dupree, the 
composer for Cirque de Soleil, has characterized that library as “…an exquisite fine 
wine … a real orchestra at your fingertips.” The companion product, Symphonic Choirs, 
was awarded the 2006 “Best Sound Library” award by the Game Audio Network Guild 
(G.A.N.G.) and another “Key Buy Award” from Keyboard Magazine. Plus, there are too 
many other award to mention here.

Starting with the very first commercial drum sample CD in the late ’80s, to the multi-
ple-award-winning “Bob Clearmountain Drums” sample collection soon thereafter, Doug 
Rogers has produced a long series of diverse virtual instruments that have defined much 
of the progress the industry has seen over these two decades. EastWest introduced loop 
sample libraries to the market in the early nineties, followed closely by the first midi-
driven loops (Dance/Industrial). He released the first sample library to include multiple 
dynamics, followed by the first sample library to stream from hard disk, an innovation 
that led to the detailed collections available today.
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He persuaded audio legend Prof. Keith O. Johnson to record EWQL Symphonic Orchestra   
and its companion library, Symphonic Choirs, and came up with the revolutionary idea 
of recording all instruments and voices with 3 simultaneous stereo mic setups so users 
can control the tone of the performances and the acoustics of the concert hall, as well 
as create surround sound mixes.

His latest productions include Quantum Leap Pianos, another 3 mic setup, and the most 
detailed virtual piano collection ever produced; and Fab Four, inspired by the sounds 
of the Beatles, featuring the same kind of vintage instruments and original EMI/Abbey 
Road recording equipment as the Beatles used to create their music. He persuaded 
audio legend Ken Scott, who was involved in the recording of five Beatles albums, and 
engineer for “Magical Mystery Tour” and “The Beatles” (also known as the White Album) 
to work with him on Fab Four.

At the 2007 NAMM convention, Doug Rogers unveiled the world’s first 64-bit audio-
engine named PLAY, a technical achievement that makes possible EastWest/Quantum 
Leap’s latest collection of virtual (software) instruments, including the Symphonic Choirs 
for PLAY described in this manual.

In 2006, Doug Rogers purchased the legendary Cello Studios (formerly United West-
ern Recorders) on Sunset Boulevard in Hollywood, renaming it EastWest Studios. The 
21,000 sq. ft. facility, since remodelled by master designer Philippe Starck, houses five 
recording studios and is the world headquarters for EastWest.

Rogers worked for nearly 2 years with Starck on the project (in addition to his work for 
EastWest) and the result can now be seen at:
     http://www.eastwest-studios.com

“Doug spent, I’m sure, 10 times what he wanted to spend, and 10 times the time he 
wanted to spend on it,” STARCK acknowledges, “but I’ve never had a partner who was 
so obstinate, so stubborn, to have the right result, and so confident.”

The proud owner runs his eyes over Starck’s dazzling creation and sighs with satisfaction. 
“Everybody wants to come here,” he says. “They already know that the place sounds 
amazing, and they can’t wait to see what this man, who virtually reinvented the hotel, 
has done to reinvent the recording studio. We hope that it stimulates artists and produc-
ers to create something special, because that’s ultimately what this is all about. If they 
walk out of here with a great record, we’ve done our job—it’s a success.”

Rogers is currently working with co-producer Nick Phoenix on several new Virtual Instru-
ments projects in the new EastWest Studios.

http://www.eastwest-studios.com


EAST/WEST QUANTUM LEAP SYMPHONIC CHOIRS VIRTUAL INSTRUMENT

  5Chapter 1: Welcome

Producer: Nick Phoenix
Nick began scoring film trailers and television commercials in 1994. To date, he has ei-
ther scored or licensed music for the ad campaigns of over 1000 major motion pictures. 
Star Trek, Harry Potter 6, Tales of Despereaux, The Dark Knight, Valkyrie, The Hulk, Ren-
dition, Spider-Man 3, Golden Compass. The Assassination of Jesse James, Pirates of the 
Caribbean 3, Babel, Hitman, I Am Legend, 300, No Country For Old Men, Harry Potter 
5, The Brave One, Wall-E, Blood Diamond, Speed Racer, and Night at the Museum are 
a few recent examples. Nick and Thomas Ber gersen founded the ultimate trailer music 
company Two Steps From Hell in 2006. www.twostepsfromhell.com. 

Nick has also scored numerous TV shows for NBC, CBS, Showtime, and Fox.

The journey as a composer has also inspired Nick to record and program his own sounds 
and samples. Nick founded Quantum Leap Productions in 1997 and Quantum Leap has 
since grown to be the world’s top producer of high-end virtual instruments. A 10-year 
partnership with Doug Rogers and East West has yielded countless award winning soft-
ware titles such as Stormdrum, Symphonic Orchestra, Symphonic Choirs, RA, Voices of 
Passion, Ministry of Rock, Gypsy, QL Pianos, QL Silk, VOTA, QL Brass, QL Guitar and 
Bass, Hardcore Bass, Goliath, and Colossus.

Nick’s studio is located in Venice, California, and is 100% solar powered.

www.nickphoenix.com

www.twostepsfromhell.com
www.nickphoenix.com
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Recording Engineer: Prof. Keith O. Johnson
Prof. Keith O. Johnson has spent over 30 years developing a reputation for innovative 
thinking, technical achievement and musicianship which has elevated him to a position 
in the audio industry occupied by only a handful of visionaries. His intensive investigation 
of electronic behavior and acoustic perception have led most recently to his development 
(with digital engineer Michael Pflaumer) of the revolutionary High Definition Compatible 
Digital encoding process, produced and marketed by Pacific Microsonics (and acquired 
by Microsoft). HDCD is widely considered to be the most accurate recording process ever 
invented. His 90-plus recordings have long been considered the standard for high fidel-
ity, and include three Grammy award-winners and eight additional Grammy nominations.

SOME REVIEWS OF HIS RECORDINGS:
“How Johnson got that huge climax at the end of the Dances cleanly onto tape tran-
scends engineering and goes into the realm of magic.” -- Harry Pearson, THE ABSOLUTE 
SOUND.

“Keith Johnson’s engineering, mastering and production have, in this case, produced the 
finest orchestral recording I have ever heard…” -- Russell Lichter, SOUNDSTAGE
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Credits

Producers
Doug Rogers and Nick Phoenix

Recorded by
Prof. Keith O. Johnson

Custom recording equipment built and designed by
Prof. Keith O. Johnson

Assistant Recording Engineer
Rhys Moody

Engineering and Mastering
Nick Phoenix

Editing
Nick Phoenix, Jared Selter, Justin Harris, Jonathan Marmor,

Pierre Martin, and Arne Schulze

Art Direction
Steven Gilmore and Doug Rogers

WordBuilder concept by
Nick Phoenix and Nuno Fonseca

WordBuilder software by
Nuno Fonseca

Software 
Doug Rogers, Nick Phoenix, Klaus Voltmer, Klaus Lebkucher, Patrick Stinson,  

Stefan Kersten, Toine Diepstraten, Thomas Merkle, Ezra Buchla, 
David Kendall, Nick Cardinal, and Jonathan Kranz, and Justin Harris

Manual
John Philpit
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How to Use This and the Other Manuals
All documentation for the EastWest PLAY Advanced Sample System and its libraries is 
provided as a collection of Adobe Acrobat files, also called PDFs. They can be viewed on 
the computer screen or printed to paper.

Each time you install one of the PLAY System libraries, two manuals are copied to the 
file system on your computer:
•	 The manual that describes the whole PLAY System. This, the largest of the manuals, 

addresses how to install and use all aspects of the software that are common to all 
libraries.

•	 The library-specific manual, such as the one you are currently reading. This smaller 
document describes aspects that differ from one library to the next, such as the list 
of included instruments and articulations.

Using the Adobe Acrobat Features
By opening the Bookmarks pane along the left edge of the Adobe Acrobat Reader, the 
user can jump directly to a topic from the section names. Note that some older versions 
of Acrobat Reader might not support all these features. The latest Acrobat Reader can 
be downloaded and installed at no cost from the Adobe web site. (As an example of a 
hyperlink, you can click on the last word of the previous sentence to be taken directly to 
the Adobe site.)

When reading this and other manuals on the computer screen, you can zoom in to see 
more detail in the images or zoom out to see more of the page at once. If an included 
picture of the user interface, or a diagram, seems fuzzy or illegible, then zoom in using 
one of several means provided in the Acrobat Reader software. Note that images are 
clearest and screen shots most legible at 200% and next best at 100%.

The Master Navigation Document
Because the EastWest PLAY System is a collection of components, each with its own 
User’s Manual, a Master Navigation Document (MND) is provided to allow users to jump 
quickly between these PDFs when being read on the computer screen. This MND is a 
one-page file with hyperlinks to the PLAY System documentation and to all the library 
manuals. Hyperlinks to this Master Navigation Document are found on the title page of 
each chapter in each document. From there, you can open any other document in the 
collection.

For example, if you’re reading something in this documentation for the Quantum Leap 
Gypsy library, and need to open the manual for the PLAY System as well, go to any chap-
ter title page and click on the link that says, “Click on this text to open the Master Navi-
gation Document.” It will open in a new window on the screen. In that document, click 
on the icon for the PLAY System and its manual will open in the same window (hiding 
the MND). You now have both the Gypsy library manual and the PLAY System manual 
open in separate windows so you can refer to them both.

www.adobe.com
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Online Documentation and Other Resources
For the most up to date information, visit the support pages at EastWest’s web site. 
There you can find:
•	 information made available after these manuals were written
•	 FAQ pages that may already list answers to questions you have
•	 suggestions from EastWest and other users of the EastWest PLAY System
•	 news about upcoming releases

The address is:
 http://support.soundsonline.com

You can also visit the EastWest online forums. There you can read comments and ques-
tions from others who use EastWest products and post your own. The many forum par-
ticipants are a good source of helpful information about both the technical and musical 
aspects of this software.

The address of the forums is:
 http://www.soundsonline-forums.com

http://support.soundsonline.com
http://www.soundsonline-forums.com
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EWQL Symphonic Choirs, An Overview

The Design Point For the Symphonic Choirs Library
The EastWest/Quantum Leap Symphonic Choirs virtual instrument is the result of years 
of planning, scoring, recording, editing, and programming by over 100 creative profes-
sionals. Our goal was to create a Symphonic Choirs virtual instrument that would blend 
perfectly with the multiple-award-winning EastWest/Quantum Leap Symphonic Orches-
tra—and could be reproduced in surround sound—recorded where choirs and orchestras 
sound most natural, in a state of the art concert hall.

First, we had to find the right team to execute the plan. To capture the sounds, we 
needed someone with an impressive history of recording choirs and orchestras live. The 
answer was Prof. Keith O. Johnson. His 90-plus recordings have long been considered 
the standard for high fidelity, and include two Grammy award winners and eight ad-
ditional Grammy nominations. All of the recording equipment used in the project was 
either hand-built or extensively modified by him to optimize fidelity. Prof. Keith O. John-
son had previously recorded EastWest/Quantum Leap Symphonic Orchestra, so it was an 
obvious choice.

Next, we had to find the right concert hall in which to record EWQLSC. Fortunately, his 
experience was invaluable here as well. He had recorded in most of the “critically ac-
claimed” concert halls throughout the world, and had a short list of favorites. After the 
success of EWQLSO we decided to use the same concert hall to record EWQLSC.

Once the recording was completed, the post-production team was put to work, which 
included some of the finest sound designers and programmers in the business. Special 
software was developed to edit the multiple tracks simultaneously, and keep them in 
phase. An advanced version of our revolutionary WordBuilder™ software for both PC and 
Mac was developed specially for EWQLSC. Nearly a year of post-production was neces-
sary to achieve the final result—a result we are all extremely proud of.

We hope you enjoy EWQLSC as much as we do—and we would love to hear what you 
create with it. Explore the many sections of this Guide, especially the sections on the 
WordBuilder™ software where we expect you will spend most of your time, and use it to 
spark the endless creative possibilities of this ground-breaking virtual instrument!

     Producers Doug Rogers and Nick Phoenix 
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Recording Notes
EWQLSC is a sample library that can produce full multi-channel sound like that from a 
good recording session in a concert hall. The user can manipulate multi-channel files 
within each sample to move a section of the choir, create fully diffused or highly focused 
sound, as well as offstage effects that have the same acoustic character as having mi-
crophones on stage and mixing them.

Each choir sample contains high-resolution components recorded in a state of the art 
concert hall from microphone groups placed to achieve close, full, and ambient sound. 
Microphone placement is modeled after traditional Decca setups. The choir and solo-
ists are placed on stage as they would perform, so that signals from these microphone 
groups can be mixed and have the general technical feel and acoustic properties of a 
live session.

In addition, the placement of the choir correlates with the orchestral instruments re-
corded for EastWest/Quantum Leap Symphonic Orchestra, achieving a unified choral and 
orchestral mix when the two libraries are used together. Consistent microphone place-
ment for the two sets of samples allows them to work together perfectly whether building 
stereo or surround sound recordings.

AdVANCEd: A “Decca tree”—for those interest-
ed—is an arrangement of three microphones 
originally designed at the English Decca Re-
cords, and still used for orchestra recordings, 
especially when recording movie scores. The 
mics are arranged as in the diagram at the right. 
Because of the 2-meter spacing between the 
left and right mics, the audio provides the inten-
sity cues necessary for detailed stereo imaging 
while including sufficient phase information to 
produce an open and spacious sound. In addi-
tion, the middle microphone generates a solid 
central image.

Much post-production work and active DSP is mandatory to align the multiple time-
phase paths from all of the sample groups. In addition, a large concert space was re-
quired to avoid claustrophobic wall sounds and to capture the choir sound we hear at an 
appropriate distance. These ultimately achieve overall mix clarity.

To provide process headroom for this work, a super resolution recording chain was used. 
FM microphone responses extended to at least 26 kHz, all signal paths had minimal 
discrete circuit electronics, and conversions and files were at least 24-bit, 88.2kHz. 
(We also recorded everything at 176.4kHz for future updates). Hence the Gigabytes of 
data needed to access the sounds of instruments from different angles, placements and 
distances. The six-channel high-resolution files containing close, full and reverberant 
feeds can produce a real 3D orchestral sense like that from a good recording. To do this, 
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simplified user commands or pre-setable instrument placements replace outmoded pan 
and gain controls functions. The new controls make complex adjustment of direct-to-
reflected sound, time-phase relationships, and equalizations to track a section’s place-
ment. In this manner, a section can be accented within the whole choir, brought forward 
in the mix, or moved off stage and the acoustic sound will correlate.

Recording Practice
A good recording setup often requires a close mic accent pickup to assist the ear in 
focusing on an important phrase in the polyphonic mix. Once used, the accent is of-
ten removed, as only a few of these spots are effective at any one time. Sometimes, a 
reverberation pickup is added or increased to restore a correct sense of hall response 
to instrumental and choral power. Generally, a good recording setup for a concert hall 
has accent capability and will be much like early big sound Decca setups: omni- or 
non-directional pickups at front; a center tree, often of directional microphones; sev-
eral close placed accents; and a hall sound microphone group. Combinations of phase 
interferences, sonic bleeds to microphones, time arrivals, and special energy convey a 

“best seat” perceptual experience even though the microphones are much closer to the 
performers than is the listener in the hall. The sense of vocal directionality and its effect 
on stage and hall sound is evident.

Post Production
The EWQLSO and EWQLSC samples originate from this Decca setup. The user can ma-
nipulate or mix file perspectives to work a composing project with the same mix capabili-
ty available in most soundstage and classical recordings. Microphone pickups are select-
able, allowing the user to mix and create a complex full sounding performance. External 
equalization adjustments can make soloists be very soft yet have pinpoint resolution in 
a lush full ensemble. Offstage singers can sound diffuse and merge into 5-channel sur-
rounds without creating distraction. Stereo accents with time-phase control can extend 
near field images beyond the speakers, a useful effect for computers and gaming.

Three-Dimensional Samples
Three file groups operate in conjunction for each choral section, soloist, or sample. They 
provide:
•	 a full soundstage
•	 a close, focused sound
•	 the hall response
All three pickup signals are synchronized to the choir’s position for correct time-phase 
arrival, as well as pre-equalized so they will fit into a traditional large-scale mix, with 
both other sections and instruments from EWQLSO. In this manner, other preset syn-
chronization and mix variations can be made to modify the placement of a section or 
soloist within the full sound of all choral parts and instruments. Such automatic options 
are not only convenient but they perform very well and reduce processing requirements 
to help allocate computer resources to create the complex real sound of a good recording.
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One-Dimensional Samples
Note that a one-dimensional sample, even with extensive electronic support, doesn’t cre-
ate the varying spatial energy relationships that occur when singers sing different notes. 
The reflected sounds from all the surfaces of a concert hall mix audibly in a good space 
to provide the whole listening experience. Small room and anechoic samples lack this 
complexity, a serious problem when attempting concert hall reality. Convincingly com-
plex—and therefore, realistic—sound radiation cannot be achieved with current sound 
processing software; the EWQLSC sample library was made in a big space, where mul-
tiple paths for reflections achieve the sense of space appropriate to a concert hall.

     Recording Engineer Prof. Keith O. Johnson

Two Revolutionary Concepts
The first of these revolutions actually began with the companion library, EastWest/Quan-
tum Leap Symphonic Orchestra, but bears repeating here: the recording of 3 microphone 
positions to achieve concert hall realism unparalleled in sampled orchestras. This fea-
ture is described in detail starting on page 88.

The second revolution, unveiled with EastWest/Quantum Leap Symphonic Choirs, is 
WordBuilder, an application that lets the composer type sentences that the choirs sing. 
A large part of this manual is devoted to various aspect of WordBuilder, starting with a 
tour of the program on page 33, and continuing with an in-depth look at how to use the 
application starting on page 49.
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The Instruments in EWQL Symphonic Choirs
IMPORTANT NOTE: This version of the manual applies only to the basic Symphonic Choirs  
Virtual Instrument, without the optional Choirs Expansion content. If you have bought 
a license for the Expansion module, check to see whether there’s another manual that 
includes information about that extra EastWest/Quantum Leap product.

The “instruments” included within the EastWest/Quantum Leap Symphonic Choirs are 
those listed below. Note that a few are only included with the optional Choirs Expansion, 
as indicated below.
•	 Choirs in 7 voice types. These are the only instruments that use Wordbuilder to create 

the sound of sung speech.
 ʳ Sopranos
 ʳ Altos
 ʳ Tenors
 ʳ Basses
 ʳ Boys
 ʳ Women *
 ʳ Men *

•	 Choirs in 5 of the above voice types. In these “instruments” the vowels and conso-
nants can be played individually in case you want access to a specific phonetic letter 
out of the context of speech. Also included are choral effects such as shouts, whis-
pers, and falls.
 ʳ Sopranos
 ʳ Altos
 ʳ Tenors
 ʳ Basses
 ʳ Boys

•	 Soloists in 3 voice types. These are vowels and other open sustained phonetic sounds 
controlled with keyswitches.
 ʳ Sopranos
 ʳ Altos
 ʳ Boys

For specific information about these “instruments,” see the chapter called Instruments, 
Articulations, and Keyswitches later in this manual, starting on page 99. (Or click on the 
page number to jump there, if reading this on a screen.)

* The “Women” voice type creates a single range of female voices using the Alto samples 
at the bottom and Soprano samples at the top. Likewise, the “Men” voice type combines 
Bass and Tenor samples to create a single range of male voices.
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WordBuilder
This software tool is the primary interface for constructing a choral performance. It is 
here that the composer or recording engineer literally spells out the words that the choir 
sings and specifies the fine details of the performance. The user is given complete con-
trol over how long the choir holds each consonant and vowel as well as the constantly 
changing dynamics that can give a choral track added realism (if that’s the goal). Or the 
user can accept the default settings and get less polished but faster results, perhaps for 
a preliminary mock-up.

When setting English words, one has a choice of typing the text with any of the following 
alphabets:
•	 standard spelling
•	 an easy-to-learn phonetic alphabet
•	 Votox, a phonetic alphabet that EastWest/Quantum Leap created specifically to match 

WordBuilder’s sung speech capabilities

WordBuilder includes a 100,000-word dictionary (from CMU) for translating American 
English spelling to a phonetic spelling. When typing with one of the phonetic alphabets 
listed in the second or third items above, the symbols are listed on the screen to assist 
the memory. When setting text in languages other than English, or with pseudo-words, 
like “be-bop-a-doo,” one must specify the sounds in one of the two phonetic alphabets 
listed above.

WordBuilder runs in either of two modes. As a plug-in it is hosted in another program, 
usually a sequencer. As a stand-alone module it runs on its own, having equal status 
with the other programs with which it communicates. The choice of which mode to use 
depends on factors discussed later in this manual.

What’s Included
This EastWest/Quantum Leap Symphonic Choirs Virtual Instrument you purchased in-
cludes all the following:
•	 a complete set of sample-based instruments, enumerated later in this manual
•	 approximately 38.5 Gigabytes of 24-bit, 44.1 kHz samples
•	 the EastWest PLAY Advanced Sample Engine
•	 the unique authorization code that identifies the license you bought
•	 manuals in Adobe Acrobat format for both the EastWest PLAY System and the East-

West/Quantum Leap Symphonic Choirs Virtual Instrument
•	 an installation program to set up the library, software, and documentation on your 

computer
•	 an Authorization Wizard for registering your license in an online database

One required item not usually included is an iLok security key. If you already have one 
from an earlier purchase of software, you can use it. Otherwise, you need to acquire one. 
They are available from many retailers that sell EastWest and Quantum Leap products, or 
you can buy one online at www.soundsonline.com.
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Hardware Requirements
See the Play System manual for a complete list of the Hardware and Software Require-
ments for installing and running any PLAY System library. In addition, the available 
space on the hard drive required for a full installation of EastWest/Quantum Leap Choirs 
is approximately 39 GB (Gigabytes). 

Optional Software: MIDI Loopback Connectors
When physical MIDI devices communicate, they do so through 
hardware cables. And when an external physical device, such 
as a keyboard controller, sends data to its computer, it also 
uses a cable, typically a MIDI cable, though nowadays USB 
and FireWire cables can also carry the required data. But 
when the two devices are “virtual”—that is, they are com-
puter programs only acting like traditional MIDI boxes—you 
cannot run a cable from one program to another program 
inside the same computer.

Instead of running a MIDI cable from your computer’s MIDI 
Out port to the MIDI In port, you need what’s called a loop-
back connector. This is a software driver that exposes several 
ports. Each port can be connected to a MIDI In or MIDI Out 
within a program that knows how to talk MIDI—for example, 
the PLAY program, a sequencer, or WordBuilder.

Think of a loopback connector as a set of “virtual MIDI ca-
bles.” It is best to obtain one that exposes multiple MIDI In 
ports and MIDI Out ports. Connect the same-numbered In 
and Out ports between a program that sends data and one 
that receives it, and you have a way for them to communicate.

For those using Symphonic Choirs together with WordBuilder exclusively in a sequencer, 
a loopback connector is not required; therefore, this software is considered optional. For 
those running the programs in standalone mode—even if only some of the time—this 
software is required.

On the Apple Macintosh, a loopback connector is already part of WordBuilder, and the 
ports appear in drop-down lists that ask for MIDI In and Out connections.

On a Windows PC, you have to obtain one. There are many to choose from. Some are 
a free download; others are commercial versions with extra features. Suggestions are 
below. Some can be downloaded from more than one site, so run an online search to 
determine the best place to obtain your copy.

Here’s a list of 4 loopback connectors that are known to work.
•	 Maple Virtual MIDI Cables
•	 MIDI Yoke

In

In

In

Out

Out

Out

virtual MIDI cable 1

virtual MIDI cable 2

Sequencer

WordBuilder

Symphonic Choirs
running in PLAY
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•	 Musiclab’s MidiOverLan (commercial software; also works between separate comput-
ers, including PCs to/from Macs)

•	 Hubi’s MIDI Driver

Make sure you obtain virtual MIDI cables that work within the operating system you 
intend to use (Windows XP, Windows Vista, Mac OS X) and the correct 32-bit or 64-bit 
version.

With the MapleMIDI installed, for example, the choices for 
a MIDI Out connection might look something like the drop-
down list at the left. The four choices with “Maple” in them 
are the output ends of four virtual cables.

If you select “Out: Port 3” in WordBuilder, for example, then 
you should select “In: Port 3” in PLAY to make the connec-

tion. The next two diagrams shows how to do that in PLAY. First, open the Settings dialog 
and click on the MIDI tab. Make sure 
that all the listed ports you might want 
to use for MIDI input are checked at 
the right. By leaving unchecked those 
ports you will never use, you will pre-
vent them from showing up unneces-
sarily when selecting a port from the 
drop-down list. You should only need to 
do this step once and your selections 
will be remembered.

For every new voice you open within PLAY, you need to select the port 
from which it will receive MIDI data. The image at the left shows where 
you make this selection in the PLAY window. In this example “Maple 
Midi In: Port 3” is being selected. That choice matches the “Out: 
Port 3” selected in WordBuilder, above, which now allows WordBuilder 
to send its output directly to the PLAY engine and its samples.

When using WordBuilder as a plug-in within a host program, there’s no need for a Loop-
back Connector. The plug-in’s interface, such as VST MA or MFX, handles the MIDI data.

Installation Specifics
Most of the instructions for how to install any library in the PLAY system are in the main 
PLAY System manual. Because Symphonic Choirs also has to install WordBuilder, there 
is an extra step in the installation process, as described below. The exact look of this 
choice depends on your operating system, so read the correct section below.
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On a Mac
The installation on a Mac takes you through a series of pages that ask you questions about 
your system. The image below shows that you must make sure the line “WordBuilder for 
PLAY” is checked when you get to that page (if you want WordBuilder installed).

On a PC
When installing the Symphonic Choirs on Windows, you need to install Symphonic Choirs 
for PLAY, as described in the main PLAY System manual. Once you finish the main in-
stallation process, it is necessary to follow the following steps in order:

1. reboot the computer
2. load the valid license into your iLok key (as described in the PLAY System manual) 

and insert the iLok key in a USB port on the computer where WordBuilder is being 
installed

3. run the separate WordBuilder installer

Users on a 64-bit operating system must run the 64-bit Wordbuilder installer. Likewise, 
32-bit Windows users must run the 32-bit WordBuilder installer. For users using 32 bit 
applications in a 64-bit OS, they can access the 32-bit components within the 64-bit 
installer.

Important exception: For Sonar (which requires the MFX version of the plug-in), East-
West does not support using 32-bit WordBuilder within Sonar–x32 on a computer run-
ning a Windows 64-bit operating system.

The WordBuilder installer is very straightforward and in some cases requires no choices 
from the user. For those running the 64-bit installer, you will see the following page dur-
ing the process. This screen allows those using Cubase in a 32-bit environment to install 
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the 32-bit VST plug-in (in addition to the other option, standalone version). Everyone 
else should install only the other choice: “WordBuilder for PLAY 64 Bit.”
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The EWQL Symphonic Choirs User Interface
Each library presents its own interface when one of its instruments is the current one, 
as specified in the Instruments drop-down in the upper right corner. The image at the 
bottom of the page provides an overview of the entire window in Player View when the 
current instrument is from the Symphonic Choirs library.

Much of this interface is shared by all PLAY System libraries, and the common features 
are described in the PLAY System manual. The Choirs-specific controls described later 
in this section are those listed on the next page. If you don’t see a control described in 
this chapter, look at the PLAY System manual; that’s the other manual installed on your 
hard drive during program setup.
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The controls described in this manual are:
•	 Channel Source
•	 Tune
•	 Master Pan, Volume, Mute, Solo, and Audio Channel Output
•	 Microphones
•	 Performance (Portamento, Repetition, Legato, and Round Robin Reset)
•	 Stereo Double
•	 Reverb Master
•	 Voice Limit
•	 Articulations
•	 the graphical representation of the Envelope

Important Note for the “Multi” Choirs
Anytime you open an instrument from the Multi” folder in the Symphonic Choirs browser, 
PLAY opens more than one—up to 12—instruments. If you open the Instrument drop-
down in the upper right corner, you will see all the currently open instruments. They work 
together to play all the phonetic sounds it takes to generate sung words.

When you make any change to one of the instruments, it is important that you make the 
same change to all the other instruments in the multi. For example, if you pan left the 
instrument on MIDI channel 1 and do not repeat that change on the other instruments 
in the multi, when you play a phrase in WordBuilder, you will hear some of the phonetic 
letters sung in the center and others sung from the left.

Master Controls
The Master controls are presented in a strip along the right side of the 
EWQLSC interface. They affect the overall output for the selected voices.

Channel Source
In the upper right corner is the Channel Source drop-down list. Use this list 
to choose how you want to use the two stereo channels of the output:

Stereo uses the two stereo channels as they were originally recorded, with no 
added processing.

Mono (Sum) combines the left and right channels into an output that is identi-
cal in both channels, approximating the sound of a single microphone at the 
center of the stage.

Mono From Left copies the left channel of the audio to the right output chan-
nel, discarding the audio from the right channel.

Mono From Right copies the right channel of the audio to the left output chan-
nel, discarding the audio from the left channel.
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Stereo (Swapped) uses both stereo channels but reverses the left and right audio. Because 
of the natural positioning of the choirs on the concert stage in Symphonic Choirs, this 
choice appears to reverse the natural layout in effect when these Choirs were originally 
recorded. 

Most applications will use the Stereo setting to achieve the natural stereo ambience. One 
of the Mono settings might be used to bring a single voice to center-stage, to create the 
feel of a pre-stereo recording, or for other special effects.

The Tune Controls
These controls include two buttons to select between Coarse tuning and Fine tuning as 
well as a knob and two digital readouts that allow the user to change the Coarse and Fine 
tuning settings. When set at 0,0 the instruments play at concert pitch. Coarse tuning 
adjusts the pitch up or down in semitone increments. Fine tuning, measured in “cents,” 
moves the pitch up or down in increments of 1/100th of a semitone. One possible use is 
to move Symphonic Orchestra up or down to the same pitch as live recordings or other 
sample libraries.

Adjustments can be made by turning the knob (moving up or down with the mouse but-
ton held down) or by selecting one of the two digital readouts and entering a new value 
(by typing a number or by using the Up Arrow and Down Arrow keys on the computer key-
board). Double-clicking the knob returns the value to 0 for whichever mode is selected, 
Coarse or Fine.

AdVANCEd: In PLAY, there are two ways to transpose a musical phrase—the Transpose con-
trol and the Tune control—but they work very differently. (1) The Transpose control can 
only move notes up or down in semitone increments, nothing smaller. It does not change 
the audio data; instead, it replaces the incoming MIDI note with a higher or lower value. 
For example, if the Transpose control is set to +2, playing MIDI note 60 (Middle C) will 
cause PLAY to play back the audio for note 62. (2) The Tune control allows adjustments 
as small as 1/100th of a semitone. The audio data is stretched over time (to lower the 
pitch) or compressed (to raise the pitch). For small changes of less than a quarter tone, 
the effect on the timbre is negligible; the larger the change in pitch, the more noticeable 
the distortion. Note that only the Tune control can let an instrument play above or below 
the range of provided samples. Finally, transposing has almost no effect on CPU usage; 
adjustments in tuning require significant CPU processing.

Pan Control
The Pan knob moves the apparent position of the sound source left or right in the audio 
field by adjusting the relative loudness of the signal in the left and right output channels. 
It preserves the relative panning for the individual panning knobs in the Microphones 
control.

The choir voices are already located in their correct position on stage as captured in the 
Stage and Surround mics. The Close mics were recorded with the singers directly in 
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front of the stereo microphones (so in the center), but the Close instruments have their 
Pan control adjusted to sound in the same location as the other mic positions. It is not 
necessary to adjust the Pan control of individual singers or sections, but you can use this 
control to achieve a more personal sound or special effects.

Master Volume Control and Meters
This vertical slider adjusts the volume of the final output. It preserves the relative mix of 
volumes specified in the individual sliders within the Microphones control.

The two vertical volume meters—for the left and right audio channels—display the real-
time volume of the output signal.

Mute and Solo Buttons
The Mute button temporarily silences the output for the selected articulation 
file without affecting other open articulation files. (Note that the Mute but-
ton—like all the Mute buttons in PLAY—does not stop PLAY from processing 
the MIDI and audio data for received note data; therefore, using the Mute 
button does not reduce the load on the computer’s CPU. If you want to tem-
porarily turn off the processing for this articulation file, uncheck the Active 
checkboxes for all loaded entries in the Articulations control.)

The Solo button temporarily silences the output for all articulation files that 
are not currently soloed. (The same note about CPU load from the previous paragraph 
applies here, as well.) Use this button to listen to the sound of one voice—or just a few—
without the distraction of others playing at the same time.

Output Channels Control
This drop-down list at the bottom of the Master controls (as show in the image at the 
right, above) allows the user to select the pair of stereo audio channels to which the 
output will be sent. This control can be used to send the audio output from each loaded 
instrument to separate audio tracks in the system’s sound cards (when in standalone 
mode) or in the host sequencer (when in plug-in mode).

In the case of Symphonic Choirs, you should not separate the audio output for the 6 
instruments that PLAY loads for the WordBuilder voices (or the 12 instruments for the 
Men and Women instrument types). The 6 (or 12) instruments are acting as a single 
instrument and need to have their audio directed to a single output.

If two or more voices within the same instance of PLAY share the same output channels, 
then their audio signals will be mixed into a single stereo pair of audio channels.
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Microphones Controls
When EastWest/Quantum Leap recorded the voices in Symphonic Choirs, it used three 
sets of microphones in different parts of the concert hall:
•	 Close: directly in front of each choral section
•	 Stage: centered at the front of the stage
•	 Surround: high above the back of the house
Details about the three microphone positions are provided starting on page 88.

The Microphones controls, shown at the right with an Output 
drop-down list open, allow the user to select the microphones 
from which to use the recorded audio and how to mix them when 
generating audio tracks. The knobs at the top can pan the audio 
separately within the sound space. The volume sliders can adjust 
the individual loudness of each microphone in the mix.

The three lights above the word “Loaded” indicate whether the 
samples for that microphone position have been loaded. Clicking 

on any of the lights toggles it, loading or unload-
ing the indicated samples from memory. Note 
that when you click on a light to load samples for 
a new microphone position, a small window, like 
the one at the left, appears to show you the prog-

ress and let you abort the loading of samples if you change your 
mind.

At the bottom is a Mute button (with the letter M) and an output 
button (with three dots on it). The Mute button temporarily si-
lences the output for that microphone. The Output button allows 
the user to specify the stereo track to receive the audio output from this microphone. 
Note that “Default” sends the output to whichever output pair is selected in the main 
Output button in the lower right corner of the user interface.

Note that in the case of the WordBuilder voice types, each multi loads either 6 or 12 
instruments at once. If you plan to send, for example, the Close and the Stage mics to 
separate audio channels, you need to change that setting individually in all 6 (or 12) of 
the instruments within the multi.

Performance Controls
There are four buttons grouped together in the Performance 
section. They include three buttons for turning on and off 
scripts specific to Symphonic Choirs that control performance 
parameters,

•	 Portamento
•	 Repetition
•	 Legato
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and one button for resetting the Round Robin counters. See the section on Performance 
Scripts, starting on page 82, for information on how to use these scripts.

When you first open an articulation, all three scripts are in the default state set by East-
West. If you want them to open with a different default, you will need to save the .ewi 
file that way and load your new version.

Portamento Button
Portamento, also sometimes called glissando, is the technique of a continuous slide in 
pitch from one note to the next note in the phrase. Portamento, as used in this virtual in-
strument, is usually a short, anticipatory movement between the pitches of two adjacent 
notes. This technique is most common in strings, the trombone, the human voice, and 
several other instruments that are not restricted to playing notes of the diatonic scale. 
The effect of turning on portamento in a phrase is a subtle way to increase a sense of 
realistic singing.

Repetition Button
Repetition, in this context, refers to the playing of a single pitch more than once with no 
different notes played between them in the same phrase. Turning on this button causes 
repeating notes to sound slightly different, avoiding the sense of mechanical repetition.

Legato Button
Legato is the style of playing notes in a phrase with no significant silence between them 
in order to produce a smooth and flowing melodic line. Use this button to turn on a legato 
effect for the articulation.

Round Robin Reset Button
A round robin articulation is one in which several different samples are recorded with all 
parameters, such as volume, speed of attack, and so on, being essentially constant. The 
PLAY Engine then knows to alternate between the two or more samples during playback. 
The goal is to avoid what’s often called the “machine gun effect,” in which playing the 
same sampled note repeatedly causes the unnatural sound of consecutive notes being 
mechanically identical.

Any articulation with “RR” in its name uses round robin technology. Those with an “x3,” 
“x4,” or the like in the name, use 3, 4, or more different samples for each note 

There’s one potential problem with round robin technology, and the way to solve it is the 
Round Robin Reset button. The PLAY Engine remembers which sample should be played 
the next time the note sounds. If, for example, a round-robin patch contains two samples, 
A and B, and a piece uses that note 7 times, the PLAY Engine plays A B A B A B A. If the 
piece is played again from the beginning, the engine will play starting with B, because 
that’s next in order. The second rendition will be subtly different. Being able to reset all 
round-robin articulations to the beginning of the cycle allows for consistent playback.
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You can use this button to reset all round robin articulations on demand. Or use your 
choice of a MIDI note or MIDI control code to reset them one instrument at a time from a 
MIDI keyboard or the data stored in a sequencer project. See the description of the Set-
tings dialog (in the PLAY System manual) for more information about this articulation-
specific approach.

Stereo Double Controls
This knob, with its three buttons, gives the user the option of using ex-
clusively the left stereo signal or right when “Stereo” is selected from the 
Channel Source drop-down. For any other setting, this control has no effect.

The knob lets the user determine the spread of the signals, how far apart the ear per-
ceives the stereo channels to be. Turning it all the way to the left brings the two channels 
together at the center (unless the Pan knob positions the output differently), and is the 
equivalent of turning off the controls with the On/Off button. Turning it all the way to the 
right calls for the maximum spread available. Select between the left and right signal 
with the buttons on either side of the On button.

Reverb Master
The Reverb control is described in the main PLAY System manual, 
but Symphonic Choirs—and a small number of other EastWest virtu-
al instruments—include a Master button as part of the group. When 
the button is pressed and the On light is illuminated, the Reverb for 
this instrument applies to all the other instruments in this instance 
of PLAY, including instruments from libraries that do not include a Master button.

If the Master button is already engaged in another instrument in the current instance 
of PLAY, and the Master button is pressed in a new instrument, then the settings in the 
UI of the new instrument become the settings for all instruments in this PLAY instance.

The processing of high-quality reverb can be very CPU-intensive and it is often the case 
that you want to use the same reverb on all the instruments in an audio track. Engaging 
the Master Reverb button allows you to run a single instance of the reverb processor and 
have the effect apply to multiple instruments.

Voice Limit Control
The Voice Limit control allows the user to specify the maximum number of voices to re-
serve space for in the computer’s RAM. Note that a “voice” in this context is the number 
of samples being played at once. Some EWQLSC “instruments” routinely play more than 
one sample at a time. And the release trail for each note also uses its own voice. It is 
not uncommon for a monophonic line to require 10 to 20 voices, especially when play-
ing rapidly (so that multiple release trails are playing simultaneously). The best way to 
see how many voices are required is to play the piece and watch the Voices display (just 
above the right side of the keyboard). The voice limit can be set to any whole number 
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from 1 to 999. The default value is set by EastWest for each “instrument” and can vary 
by library and instrument.

Setting the Voice Limit too low causes notes to end too soon when PLAY is forced to stop 
already playing notes in order to start a new note. If you hear notes being clipped, check 
to see whether you need to raise this setting (as described in the previous paragraph).

Setting the Voice Limit too high reserves unnecessary data buffers in RAM. The total 
number of voice buffers that can be reserved is limited by the amount of computer mem-
ory (RAM). The larger the project, the more likely it is you will run out of RAM; in such 
cases, you may want to check the Voice Limit of each instrument to determine whether 
you can reduce the value. 

The image at the left shows the Voice Limit 
spin control in the PLAY user interface set to 
32 simultaneous voices. It is also possible to 

modify this value in the Current Instrument Properties 
dialog box, which can be opened from the main menu 
and selecting Current Instrument > Advanced Properties. 
The image at the right shows part of that dialog with the Voice Limit set to 40.

Articulations Control
This control is much larger and more prominent than in some 
other EastWest and Quantum Leap virtual instruments. Where 
others show a maximum of 4 articulations at a time, EWQLSC 
shows up to 16 at once.

The first 3 columns within the Articulations control allow you 
to do the following tasks:
•	 Activate and De-activate an articulation: Click in the first col-

umn; a visible check mark means that the articulation 
will sound when played.

•	 Load and Unload samples: Click in the second column to 
release the samples from computer memory and click again to reload them into 
memory. Use this facility to unload any samples you will not be using to save CPU 
resources. A visible check means the samples are loaded.

•	 Change the loudness of the individual articulations: Click and drag up or down to make 
that articulation louder or softer (without affecting the other articulations).

The fourth column lists the name of the articulations or other components of the play-
back, such as release trails.

Be sure to read the discussion on page 90 about using the Articulations control to manage 
the release trails.
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Changing Keyswitch Notes in the Articulations Control
When viewing a keyswitch file, the fourth column includes 
the keyswitch note as a prefix. The “C#0” at the beginning 
of the “QLeg” name in the second slot in the image at the 
left indicates that the note C#0 can be used to initiate that 
articulation. The control lists the default keyswitch note for 
each articulation, but these notes can be changed.

If within the list of articula-
tions you right-click (on a PC) or Control-click (on a Mac), 
you will open a context menu listing all the available 
notes to which you can move a keyswitch. The image to 
the left show part of the context menu that opens for 
the articulation “G#0-Exp Fst.” The check mark next to 
G#0 shows the current keyswitch note. Select any differ-
ent note to change the keyswitch. The image at the right 
shows how the D1 keyswitch can be moved to A1.

This feature provides very few restriction on which note you select, so be aware of the 
following:
•	 If you assign an articulation to a note that is already a keyswitch (and don’t move 

the other keyswitch) then that note will trigger both the old and the new articulation, 
effectively playing two articulations at once. That might sometimes be useful and at 
other times a problem.

•	 If you assign an articulation to a playable note (in white on the onscreen keyboard) 
then playing that note will also change the articulation. (The articulation will be 
changed after the start of the note, so the note itself will not be in the new articula-
tion; it only starts with the next note.)

•	 If you change the keyswitch note for the currently selected articulation, then all the 
notes temporarily stop being playable until you select a new articulation by selecting 
a keyswitch note. Visually, this means all the white keys on the onscreen keyboard 
turn the darker tan color. (Remember that the lowest keyswitch note—usually C0—is 
the default keyswitch, so it is considered “currently selected” until another keyswitch 
note is selected.)

•	 If you open the context menu on a slot that does not contain a keyswitch, the value 
“None” will be selected and you will not be able to assign a keyswitch note.

•	 This feature does work on the older keyswitches in the folder “6 Old Keysw,” but 
because these files are included to provide compatibility to projects begun in earlier 
versions of EWQLSO, there are probably fewer reasons to do so than with the Master 
keyswitches.
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Note that changing the keyswitch note for any given slot in the list does not change the 
name in the list. For example, if you change the D#0 keyswitch to F1, a “D#0-” will still 
appear in the name. The only way to know the currently assigned keyswitch note is to 
open the context menu and see which note is checked.

If you use this feature often, you might consider creating your own detailed mapping of 
what notes have been moved and to where. And you might want to save the .ewi file un-
der a new name so you can recall your customized mapping for this and future projects.

The Graphical Representation of the Envelope and the Curve Knob
The Envelope Controls are described in the main PLAY 
System manual because they are common to all PLAY 
System libraries. Only some libraries include the graph, 
as shown here, so it is included in the manuals for those 
libraries only.

The Envelope has an extra knob compared to the same 
control in the UIs of other libraries: the Curve knob. It af-
fects the curve of the attack (but is not displayed in the 
graph just above). Turn the knob to the left (toward 0%) to have the attack start slowly, 
with most of the rise late; turn it to the right (toward 100%) to have most of the rise 
in volume near the beginning. This difference can be heard most distinctly with longer, 
slower attacks.

Note that the total width of the graph represents the total length of all phases of the en-
velope. Therefore, when you change something in one part of the graph, for example, the 
decay, you may see the slopes of other components, the attack and the release, change 
as well because those phases become a larger or smaller percent of the whole; this is as 
expected.

The Browser View
The Browser behaves identically among all PLAY System libraries. Read the main PLAY 
System manual for information about how to use that view.
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A Quick Tour of WordBuilder
This chapter introduces a few of the important concepts about WordBuilder by briefly 
describing the user interface, and how to perform some basic operations. Each of the 
topics in this overview is covered in much more detail later in the manual.

Choirs and Voices
When started as a stand-alone module, WordBuilder 
opens Voice windows.

•	 When started on a Windows PC, all the windows open 
inside a frame, allowing you to work on several voice 
files at once within the same program.  The image at 
the right shows two voices (First Sopranos and Sec-
ond Sopranos) as part of a single choir. 

•	 When started on a Mac, each window opens on the 
desktop, seemingly independent of the other. The 
image below shows the same two Wordbuilder voices 
open on a Macintosh.

Each voice requires a setup in the Options dialog, like what is described on page 74. 

Each voice within the choir uses its own MIDI ports for both input and output. For exam-
ple, if First Sopranos and Second Sopranos each have their own tracks in the sequencer, 
then each is set to a different MIDI port, and those same two ports are assigned to the 
two voices in WordBuilder.

In contrast, when opened in a host program, you can insert as many instances of Word-
Builder as your computer resources allow. Each instance is its own voice and is pro-
grammed individually.

The set of all voices open at once is called a choir. For example, a choir might have two 
Soprano voices and two Alto voices (SSAA). When you choose Save, all the voices are 
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written to a single file with a .cho extension. If you want to write a single voice to the file 
system—for example, to copy it into a different choir—then you need to Export it from 
one and Import it into the other.

When a project is first created, it looks like the image above. It contains no text in the 
Text Editor control; it is ready to receive its own text and other parameters.

In the upper-left corner of each voice is various information about the voice being man-
aged with this window. The large rectangle in the top center of the window, called the 
Text Editor, displays the text to be sung. In the upper-right corner are various tools that 
provide instant access to several frequently used operations. Horizontally across the 
middle of the window is displayed detailed information about the principal units of pho-
netic speech: the word, the syllable, and the letter. At the bottom is a grid in which you 
can fine-tune the timing and dynamics of each phonetic segment of the text.
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Note that the image on the previous page includes a row of colorful tool icons near the 
top. If you are not seeing these on your screen and you want to, then open the View menu 
and select the Toolbar option.

Voice Settings
The values you choose when you open a new voice are displayed 
in the upper left corner of the voice window. You are most likely 
to refer to these setting when you have more than one voice 
window open at once. Here you can see the voice type, your in 
and out MIDI ports, and your in and out MIDI channels.

The two plug symbols next to the In and Out MIDI channel num-
bers flash whenever a MIDI message is received (the left sym-
bol) or sent (the right symbol). Click on the vertical bar to the right of these fields to open 
an Options dialog box, allowing you to change these settings.

These flashing MIDI symbols are a quick check that MIDI data is flowing in and out of 
WordBuilder. If you are not hearing the choir when you play on your MIDI keyboard, these 
flashes can help you determine you how far the MIDI data is travelling in its path from 
keyboard or sequencer to WordBuilder to Symphonic Choirs.

The Text Modes
Below the display of your settings are three buttons labeled English, 
Phonetics, and Votox. The button lit in bright blue (the Phonetics 
button in the image) indicates which of the three text layers ap-
pears in the Text Editor. Click on one of the other two buttons to 
change the text display to that mode. (These are called “layers” because all three ver-
sions of the text are always available, but only one layer at a time is brought to the top 
in the Text Editor window where it becomes visible.)

When you type English words in the English layer, WordBuilder automatically translates 
any word it finds in its 100,000-word dictionary into the other two layers (though they 
remain hidden until revealed by clicking on the button for that layer). When you type 
correctly formatted text into either the Phonetics or Votox layer, it gets translated into the 
other of those two, but not into English.
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When you place the cursor in the Text Editor, information about the selected word, 
syllable, and letter appears in the three controls across the middle of the window, 
as shown on the previous page, where the word English word “with” was selected. 
At the same time, in the lower left corner the Phonetics and Votox symbols are 
stacked one above the other, creating lanes (in this case 3 symbols, 3 lanes). 
Because WordBuilder uses the Votox layer when dividing a syllable into its sung 
sounds, it’s the Votox symbols that are mapped to the colored bands to the right 
of the letters; each band represent the duration of a sampled sound.

The user controls in this section of the interface are discussed in much more 
detail starting on page 59.

Typing English
When English words are typed into the Text Editor, they are color coded to indicate their 
status.

medium blue: the word was found in the dictionary

dark blue: the word has more than one entry in the dictionary; this happens when the 
word can be pronounced in two or more ways

dark red: the word was not found in the dictionary; if it is misspelled, correct it; or if it is 
not a common word, you will need to enter the word phonetically

light blue: the word was entered in the Phonetics or Votox layer, and is displayed here 
phonetically, even in the English layer

dark red: there is an error in syllable separation, or WordBuilder cannot find the word in 
the dictionary. For example, if you separate an English word into syllables, WordBuilder 
may have to set the word in red to indicate it cannot make good automatic phonetic 
separations. In this case, make the syllable separations in the Phonetics layer.

gray: a comment; the number sign, #, and all text after it on a line are considered com-
ments and not sung

The following screen shot shows many of these colors. If you’re reading this in black and 
white only, then try typing it yourself.

The proper name “Gerri” is not in the dictionary, so 
it’s in dark red. The words “must fly” and “me” were 
found, so they’re in medium blue.

When WordBuilder looked for “with” in the diction-
ary, it found two possible pronunciations. Although 
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the word is usually pronounced with the same “th” sound as in “thigh,” in certain pho-
notactic situations, it can be pronounced with the “th” sound in “thy.” Decide how you 
want it to sound in your piece, and make your choice by right-clicking (in Windows) or 
control-clicking (on a Mac). You’ll see the context menu you see here. The choices at the 
bottom are the two possible pronunciations:
•	 wid!  for the th-sound in “thy”
•	 wit!  for the th-sound in “thigh”
If the one with the check is not the one you want, click on another choice.

Because the scat syllables “she-bop” are not in the dictionary, they were entered by 
changing to the Phonetics layer and typing them in phonetically. Returning to the Eng-
lish layer, they appear in light blue, as in the image above. When writing in languages 
other than English, all text is entered this way.

Finally, the text “# sung at entrance” is a comment. It is not sung. It appears in gray.

Note that you can also insert the #-symbol to remove text temporarily from what’s being 
sung. Then delete the # and WordBuilder will sing that text again. The effect of the # 
ends at the end of the current line, i.e., until the next carriage return (which may be dif-
ferent from where the phrase automatically wraps to the next line).

The last color you might see is bright red for soloed words (described on page 62). The im-
age below shows the word “fly” soloed.

Typing Phonetically
It is also possible to enter text using one of the phonetic alphabets. You have a choice of 

either traditional Phonetics or WordBuilder’s own Votox symbols.

Most users at the beginning will find it easier to use the traditional Phonetics 
alphabet, partly because the UI provides examples of English words that con-
tain each symbol in the Phonetics “alphabet.” Next to each symbol is an Eng-
lish word; the capitalized letter in the word spells the sound of the phonetic 
symbol. As shown in the 3 images at the left, you can open the list of letters 
by clicking on the plus sign when working in those modes. You can also click 
on Tools>Phonemes in the WordBuilder menu (but only when in that mode).

Note that some symbols are two characters long; for example, “Au” is the 
vowel sound in the English word “brown.” These two-part vowel sounds are 
called diphthongs. The information in these on-screen lists—and more—is 
repeated starting on page 94 in this guide.
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To type using the Phonetics (or Votox) symbols, click on the Phonetics (or Votox) button 
at the left. Whichever language has the highlighted button is what you’re typing in.

At the right is an example of a word typed in Phonetics. It defines the sounds of 
a Latin word common in liturgical music: “lacrimosa,” which means, “weep-
ing.” Note that the syllables are separated with spaces.

And when you click on the Votox button, you can see 
the same Latin word spelled in Votox, as shown in 
the second image on the right.

You are most likely to start a project in the Phonetics 
or Votox layer if you are writing lyrics in another language, or 
have lots of extra syllables in the setting, such as, “I love you-
hoo when the moo-hoon is bri- i- i- ight, be-bops-a-doodle.”

You might also start in English, let WordBuilder translate the text to one of the phonetic 
alphabets, then make adjustments phonetically to get the exact performance you want. 
If you plan to use WordBuilder a lot, then learning to work entirely in Votox is strongly 
recommended; that will give you much more control, and it’s easier than it might seem 
at first.

The Time Editor
Just as the Text Editor gives you total control over the sounds within each of the words, 
the Time Editor allows you to fine-tune how these sounds move from one to the next over 
the course of each note in the melody.

Consider a syllable like “sweet.” Vocalists may move from the “s” to the “w” quickly or 
slowly or at any rate in between. A careful choral director may give the chorus direction 
to hold the “w” or to get into the long “e” as soon as possible. With the Time Editor, you 
have control over such decisions.

Some of the long “e” may need to continue after the end of the MIDI note because hu-
man singers take a finite amount of time to get the tongue in position to close the “t.” 
With the Time Editor, you have control of that, too.

The Time editor looks like the following image when the syllable “sweet” is selected in 
the Text Editor:
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Note that the 5 Votox “letters” have been arranged down the left side, one per row. 
Across the top is a time line with a marker every 50 milliseconds. The heavier vertical 
line just before the word “Off” divides the display into the sounds that take place during 
the note itself and the sounds heard during the release trail (that is, after the MIDI note 
ends). The five colored bars represent the duration of each Votox symbol: three during 
the note and two at the end of the note. From this display, it looks as if the “s” will be 
heard for about 90 ms; the “w” will start a little before the “s” ends, at about the 80 ms 
point; the long “E” sound will start about 175 ms into the melody note.

The “E” bar may look as if it ends at 360 ms, but if you drag the heavy vertical separator 
to the right (with the mouse) you’ll see that it continues indefinitely. That is, it continues 
until the MIDI note-off event. You do not need to specify in WordBuilder the duration of 
the note in the melody. The MIDI notes in the sequencer specify that. Or the keyboard 
player specifies that, when playing in real time.

The two horizontal bars after the vertical separator are the sound of the syllable being 
closed, so they are triggered by the note-off event. The “E” persists until the tongue can 
move into position to pronounce the “T” sound.

When you enter text in the Text Editor, WordBuilder uses default setting for how long to 
make each bar. You can use the mouse to drag the ends of the bars and change the start 
time and duration of each sound in the syllable.

As you might guess from the variety of little plus signs and minus signs at the left end 
of each lane, there’s lots more that can be done here, but that’s too much detail for this 
quick tour.

Even though the melody in the sequencer played only one note, WordBuilder triggered 
5 samples in the PLAY engine. And you are given total control over when each sample 
begins and ends as well as how much they overlap.
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Cross-Fades
Sometimes the sounds of a syllable don’t exactly follow one another; instead, one sound 
fades out as the next one fades in. This is known as a cross-fade. If you consider the 
ending of the word “throw,” the sound shifts slowly from mostly “o” to mostly “w” with 
no clear break between the two. WordBuilder handles this situation by controlling the 
relative volume of the two sounds.

Note in the image above that WordBuilder has automatically added volume envelopes to 
both sounds, causing the o sound to disappear slowly while the w sound becomes louder. 
You can, of course, modify or eliminate these envelopes if you’re looking for a different 
effect. In this example, the volume adjustments were added automatically when Word-
Builder constructing the Phonetics layer, but manual control of volume—as well as some 
other MIDI parameters—can be used on any sound in any syllable. 

The Tools
In the upper right corner is an array of seven buttons that provide 
access to several important functions.

The Undo button removes the most recent change made in the in-
terface. Clicking on the button repeatedly removes more and more 
consecutive changes. Up to 100 of the most recent changes can be 
removed.

The Redo button undoes the Undo operation. For example, clicking 
on the Undo operation 8 times in a row, and then the Redo button 8 times in a row, re-
turns you to the state of the UI before you started clicking on the Undo button.

The Reset Position button tells WordBuilder that the next MIDI note should “sing” starting 
with the first word in the text. That is, it resets the syllable position back to the start of 
the text, but it does not affect which MIDI note will next be played.

The Bypass button sends the MIDI input data directly to an output port without any Word-
Builder processing. In the Advanced MIDI Out dialog you can control to which MIDI port 
the data is sent.
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The Panic button turns off every MIDI note on every channel. This is an effective way 
to turn off a “stuck” note if, for any reason, the sample player does not receive a MIDI 
Note-Off message and a note starts playing indefinitely.

The Options button displays a dialog box in which the user can set values relating to tim-
ers, voice defaults, events, and general data. See page 74 for more detail on this dialog 
box.

The Phrases button opens a displays a menu that allows 
you to manage a list of reusable phrases or to select a 
phrase to insert in the Text Editor. See more information 
about this feature starting on page 69.
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Click on this text to open the 
Master Navigation Document

5. The WordBuilder Menus 

 43 The File Menu
 44 The Edit Menu
 44 The View Menu
 45 The Voice Menu
 45 The Tools Menu
 46 The Window Menu
 46 The Help Menu
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The WordBuilder Menus
WordBuilder includes a menu system in the frame when used in standalone mode. This 
chapter lists the various operations that can be performed from the menus. (Note that 
there are none of these menus when WordBuilder is used as a plug-in.) 

The File Menu

Here are the operations available from the File menu:

New Voice Create a new voice within this choir

Close Voice Close the active voice

New Choir Create a new choir; the current choir and all its active voices are closed first

Open Choir Open a Choir File from the file system, including all its voices; the current 
Choir File is closed first

Close Choir Close all voices

Save Choir Save a Choir File with all its voices

Save Choir As Save a Choir File under a new name on in a new location in the file system

Import Has two options:

Voice File Import a Voice File to a new voice

Voice Learn File Import a Voice Learn File—with its information about syllable timing—into 
the current choir

Export Has two options:

Voice File Create a Voice File from the selected voice

Voice Learn File Create a Voice Learn File with timing information for the selected voice

Exit  (Win only) Close WordBuilder
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The Edit Menu 

Here are the operations available from the Edit menu:

Undo Undo the last change; can be called repeatedly to undo up to 100 changes

Redo Reapply the last Undo; can be called repeatedly until there’s no more to undo

Cut, Copy, Paste The usual features

Paste Text Only Paste only text from the clipboard; no timing data is copied

Delete Delete the selected text

Select All Select all the text

The View Menu

Here are the operations available from the View menu:

Horizontal Zoom In, Out Change the zoom of the time resolution in or out in the Time Editor; has no 
effect on timers’ values

Vertical Zoom In, Out Change the height of the bars in the Time Editor

Toolbar  (Win only) Show or hide the main Toolbar

Status Bar  (Win only) Show or hide the Status Bar at the bottom of the WordBuilder window

A check next to either of the last two menu items indicates that the toolbar or status bar 
is currently visible.
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The Voice Menu 

Here are the operations available from the Voice menu:

English Change the voice mode to English

Phonetics Change the voice mode to Phonetics

Votox Change the voice mode to Votox

Reset Position Reset the syllable position so the next MIDI note will “sing” the first syllable

Reset Position to Text 
Cursor

Reset the syllable position so the next MIDI note will start at the current 
position of the cursor

Letter KS/Velocity Edit the keyswitch and velocity of the current letter

Syllable Speed Change the speed of the syllable timers

Bypass Send all MIDI data for the current voice directly to output

Bypass All Voices Send all MIDI data for all voices directly to the output channel with no 
WordBuilder processing

Properties/MIDI Open the dialog with the properties and MIDI setup of the current voice

Adv Midi In/Out Open the Advanced MIDI In or Out setup dialog box for setting extra 
parameters

Speed Learning Open a dialog box to initiate the Speed Learning feature

A check next to the selection “English,” “Phonetics,” or “Votox” indicates that that text 
mode is currently in effect.

The Tools Menu
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Here are the operations available from the Tools menu:

MIDI Panic Turn off every note on every MIDI channel

Phonemes Show or hide the display of phonetic symbols with their example words; 
grayed out when the text mode is not Phonetics

Votox Letters Show or hide the display of Votox symbols; grayed out when the text mode is 
not Votox

Options  (Win only) Open the Options dialog box

Save Options  (Win only) Save the options to a file (to be loaded every time WordBuilder is opened)

A check next to either “Phonemes” or “Votox Letters” indicates that the listing of sym-
bols (in a box to the right of the Text Editor) is currently open.

The Window Menu

Here are the operations available from the Window menu:

Cascade (Win only) Display multiple voice windows mostly overlapping

Tile  (Win only) Display multiple voice windows overlapping as little as possible

Arrange Icons  (Win only) When voice windows have been minimized, their icons are returned to their 
docked position at the bottom of the frame

Zoom Window  (Mac only) Enlarge the view of the current Voice window 

Minimize Window (Mac only) Minimize the current Voice window

Bring All To Front  (Mac only)

In addition, all open voice windows are listed at the bottom of the menu. Selecting one 
brings it to the front and makes it the current voice. The check in front of a voice name 
indicates that it is the current voice.

The Help Menu

Here is what’s available from the Help menu:
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About WordBuilder (Win only) Open the About Box (which is also the WordBuilder Splash Screen)

On the Macintosh, the Help menu also provides access to a Search function.

The About Box
An image of the About Box is shown at below. Note that the version number for the Word-
Builder you are running is included in the lower-right corner.
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Click on this text to open the 
Master Navigation Document

6. Using WordBuilder 

 49 Starting the Program in Standalone Mode
 50 Starting the Program as a Plug-in
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 69 Note Volume
 69 Using a Library of Phrases
 70 Notes from the Producers
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Using WordBuilder
WordBuilder is a tool for approximating the sound of sung speech. Its effectiveness in 
reaching that goal depends on your craft in shaping a series of phonetic material into 
realistic patterns that the listener perceives as language. Where some projects require 
intelligibility, others may need only the perception that people are singing, without the 
need for conveyed meaning. The care you need to take with WordBuilder depends on 
where your project falls in that spectrum.

The success of WordBuilder in creating recognizable words and meaningful phrases re-
lies on the programming of phonetic cues. Consonants often require the most care; their 
duration and their volume relative to the nearby vowels are often the keys to clearly enun-
ciated and understandable words. The use of small gaps between phonetic elements—
especially before an initial consonant—can sometimes make consonants stand out more 
clearly. Or the opposite technique—overlapping the end of one segment with the start of 
the next—can integrate the sounds into more recognizable patters.

The duration and loudness of a consonant are interdependent. Often the longer the con-
sonant lasts, the louder it will seem, and vice versa. You should experiment to see how 
this works on real words. Also, the type of attack chosen for a vowel after a consonant 
will have a noticeable effect on the sound of a word.

There is no fixed rule except always to listen to the words spoken and then emulate 
what you hear. Be prepared to adjust any aspect of each phonetic component, es-
pecially if intelligibility is one of your requirements. You will soon learn many 
tricks that will improve realism. Also, look for hints in the WordBuilder forum at: 
     http://www.soundsonline-forums.com.

This section of the manual describes how to use the various features of WordBuilder in 
pursuit of those goals, including how to set the parameters that control its operation. 
After reading this section when learning the program, you should consider the section as 
a reference guide any time you need to delve more deeply into a technique.

Starting the Program in Standalone Mode
When WordBuilder is not running inside a sequencer or other host program, you are 
opening the program in standalone mode. In this mode, WordBuilder is accepting MIDI 
data directly from a MIDI generator, such as a keyboard or breath controller. And Word-
Builder is communicating directly with a Symphonic Choirs virtual instrument running 
in a PLAY engine.
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Open the WordBuilder executable as you would any other program. If you installed a copy 
of WordBuilder on the desktop, then you can start it quickly from that location.

Each time you start WordBuilder in standalone 
mode (without first choosing a file to work on), the 
splash screen appears for a few seconds, followed 
by a Voice Properties dialog box, like the image 
displayed at the right. If you do not want to create 
a new voice, but to open an existing file instead, 
then click on Cancel. If you do want to create a 
new voice file, then provide a name for a new voice 
by which you can refer to it later, and select which 
of the 5 voice types in EWQLSC will supply the 
samples (Sopranos, Altos, Tenors, Basses, Boys).

WordBuilder sits between the source of the notes 
and the sample player. In the example image at 
the right, the MIDI In Port identifies that source of 
notes, which is probably a MIDI keyboard or other 
MIDI generator.

Also select the number of the MIDI channel on which note data will be transmitted to 
WordBuilder. (The Advanced buttons are discussed later in this section.)

In the MIDI Out section of the dialog box, select the port with which you’re sending data 
to the PLAY Engine. If you’re running WordBuilder and PLAY on the same computer, then 
you need to specify the same “loopback connection” as an output here and as an input 
in PLAY.

You also need to select a MIDI channel by which data will be sent to PLAY. WordBuilder 
needs to talk to Choirs for PLAY across 6 channels; it reserves 6 consecutive channels 
starting at the number you select. Unless you have a reason to do so—and that you have 
tested to know it works—it is suggested you use channels 1–6.

Advanced MIDI In and Advanced MIDI Out Buttons
The dialogs that open from these two buttons are described in detail as part of the De-
fault Voice setup. Rather than repeat the descriptions here, go to page 76 and read about 
them there. The only difference between there and here is that in this case, you are mak-
ing choices for the current voice. As described on page 76, you are setting a default that 
applies to all voices until changed here.

Starting the Program as a Plug-in
It is also possible to start WordBuilder within a host program such as Sonar, Cubase, or 
Logic. Open the host you plan to use and then follow the directions below. Make sure you 
read the directions below that apply to your sequencer or other host.
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Note that WordBuilder does not work properly in hosts that do not support “poly-after-
touch,” such as Ableton Live.

In order, the descriptions for creating a WordBuilder instance inside of the host are pro-
vided for each of the following. The number on each line is the page number. Click on 
the number to be taken directly to that description.
•	 Cubase/Nuendo 51
•	 Digital Performer 52
•	 Pro Tools  53
•	 Sonar  55
•	 Logic  56

Cubase/Nuendo
In the MIDI / Instrument track 
where you want to run Word-
Builder, click on MIDI Inserts to 
bring up the drop-down menu 
where you can insert the Word-
Builder plug-in.

If you have installed the Word-
Builder plug-in correctly, you can 
select “WordBuilder [VST].”

Then choose VST Instruments from the Devices menu. In 
the VST Instruments dialog, click on an instrument slot and 
choose “PLAY.” Then select “PLAY” as your MIDI Output.
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Digital Performer 6
These steps start by opening a Tenor voice type as an ex-
ample, but you can choose any voice type you like as long 
as you are consistent through all the steps.

1. Launch Digital Performer 6 and create a new project 
for Symphonic Choirs.

2. Create a new stereo PLAY Instrument track.
3. Set the output of the PLAY track to your preferred 

sound card output.
4. Click on the Browser button in PLAY, then find 

“EWQL Symphonic Choirs” in favorites. Select a Ten-
ors patch from the Multis folder.

5. Go to your Setup menu in DP, and go down to the 
Interapplication MIDI option, as in the image at the 
right.

6. In that window, create 4 ports in both the ‘In-
puts’ and ‘Outputs’ sections. If you’d like, you 
can name these “Sopranos Output,” “Altos 
Output,” and so on in the Outputs section, and 

“Sopranos Input,” “Altos Input,” and so on in 
the Inputs section, as in the image at the right. 
Each voice type needs 1 port.

7. Launch Wordbuilder (PLAY) from your EastWest 
folder in Applications.

8. In WordBuilder’s Voice Properties dialog box, 
choose Tenors for the voice type.

9. In the same window, choose “Tenors Ouput” for 
the MIDI input port, leave the channel at 1.

10. In the same window, choose “Tenors Input” for 
the MIDI output port, leave the channel at 1 
and Click on OK.

11. Type some words into the English text editor.
12. Back in Digital Performer, create seven MIDI 

tracks. 
13. From the Studio menu, select Multi Record.
14. For the first MIDI track, name it simply “Tenors MIDI,” set the input to your key-

board*, and set the output to “Tenors Output - 1.”
15. For the next 6 midi tracks, set their inputs to “Tenors Input - 1” through “Tenors 

Input - 6,” respectively. Set their outputs to “PLAY-1-1” through “PLAY-1-6,” re-
spectively.
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16. Record-Enable all 7 MIDI tracks, as in the image above, and you’re ready to play!  
Remember to save this as a template for future use. 

* If your keyboard is not an option under MIDI input, you can create it as a “MIDI Device” 
within the Studio menu, under Bundles / MIDI Devices.

For the rest of the Choirs sections, repeat the steps above for Sopranos, Altos, and 
Basses respectively. You can skip Step 6 as that is already set up for you the first time.

Pro Tools
These steps start by opening a Tenor voice type as an example, but you can choose any 
voice type you like as long as you are consistent through all the steps.

1. Open WordBuilder (PLAY) from your East West Program Files / Applications folder.
2. In the Voice Setup dialog box, select the Tenors voice type.
3. MIDI In should be set to EASTWEST Virtual WordBuilder 1. (PC users, see the note 

at the end of this section.)
4. MIDI Out should be set to EAST-

WEST Virtual Wordbuilder 2. Click 
OK.

5. Type a few words into the English 
Text Editor in WordBuilder (PLAY).

6. Start Pro Tools and create a new session.
7. Select Setup > MIDI > Input Filter and choose Record All, as in the image above. 

Click OK.
8. Select Setup > MIDI > Input Device and check 

all the WordBuilder ports, as well as the physical 
input of your MIDI controller, as in the image at 
the right. Click OK.

9. Create a stereo Instrument Track.
10. Load PLAY (Stereo) as an insert in the new Instru-

ment Track.
11. In PLAY, Click on the Browser button and select a Tenors WB Multi from the list of 

EWQL Choirs Instruments > Multis.
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12. Create a MIDI track in Pro Tools and name it “Wordbuilder.”
13. Set the MIDI in to your MIDI Controller input port. Do not leave this input set to 

All. It must be set to a physical MIDI input.

14. Set the MIDI out to “WordBuilder 1, Channel 1.”
15. Create 6 new MIDI tracks.
16. Name the 6 new MIDI tracks “Choirs 1” through “Choirs 6.”
17. Set the MIDI input for “Choirs 1” to “Choirs 6” to the values of 

“Virtual WordBuilder 2 channel 1” through “… channel 6.” The 
channel should match the track name. (e.g., “Choirs 3” should be 
set to “Wordbuilder 2 - channel 3”).

18. Set the MIDI output for “Choirs 1” to “Choirs 6” to the PLAY plug-
in. The channel should match the track name. (e.g., “Choirs 2” 
should be set to “PLAY 1 - channel 2”).
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19. Hold the SHIFT key and click on the record enable buttons for all 7 MIDI tracks 
(including the WordBuilder track), as in the tall, narrow image at the right on the 
previous page.

Always leave “Choirs 1” to “Choirs 6” record-enabled. When you no longer need to re-
hearse or record with Symphonic Choirs, you should take only the WordBuilder track out 
of record mode. Please note: You should only record with WordBuilder using Destructive 
Record Mode.

* Note: Virtual WordBuilder ports are only available on the Mac version of WordBuilder. If 
you are using a PC, you’ll need to download one of the loopback connectors described 
on page 17. To follow the instructions above, replace Virtual WordBuilder with the MIDI 
loopback connector you are using. For example, Virtual WordBuilder port 1 channel 1 
would correspond to MIDI Yoke port 1 channel 1, if that’s your loopback connector.

Sonar
Inside Sonar, insert the “play_VST” module in the Synth Rack (either from the Insert 
menu or from within the Synth Rack window). Then load “play_VST” into the MIDI Out 
port of the track you want to hold the MIDI data. Assign “1” to the MIDI Channel.

To install WordBuilder, right-click in the Effects Bin of a MIDI track (if you don’t see 
the MIDI Effects bin, click on the “All” tab all the way at the bottom). If WordBuilder 
has been installed correctly, then it should appear in the context menu, so select it. 
The picture at the right shows 
the “play_VST 1” already in the 
MIDI Out port and “WordBuilder 
[MFX PLAY]” being inserted into 
the “FX” Bin.
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Enter notes into the track, as shown in the first image above, and words into WordBuild-
er’s Text Editor. When you play the track, you should hear Sonar sing the words you typed.

WordBuilder Running Standalone with Logic
These steps start by opening a Sopranos voice type as an example, but you can choose 
any voice type you like as long as you are consistent through all the steps.

1. Launch WordBuilder (PLAY) from your Applications > East West folder.  Set the 
voice type to Sopranos (for this example). Set the MIDI IN Port to “EASTWEST 
Virtual Wordbuilder 1,” and set the MIDI OUT Port to “EASTWEST Virtual Word-
builder 2.” (Leave the channels set to 1.) In the main Wordbuilder window, type 
some words in, or load a phrase.

2. Open a new project in Logic. Create a new Software Instrument. Instantiate PLAY 
onto this Instrument track, and rename the track itself to “PLAY.” Open the PLAY 
plug-in and within the Browser view select a Sopranos multi (.ewi file) from the 
EWQL Choirs Instruments > Multis folder.

3. Go to the Window menu and select the Environment window. Select the “Clicks & 
Ports” environment page. There you will see the physical and virtual ports available 
on the system (including the 4 WordBuilder virtual ports). You will also see here 
a Sum cable from the Physical Input ports going to a series of objects which lead 
eventually to an object called Sequencer Input. Remove this virtual cable from the 
environment by clicking on the cable to highlight it and hit the Delete key. (Not 
doing this step causes a MIDI loop.)

4. Create a new cable from your Master Key-
board’s port (usually port 1 or 2) in the “Phys-
ical Input” object, and connect to the Input 
Notes object—it looks like a keyboard—or 
where the Sum cable was before you deleted 
it.
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5. Create an Instrument from the New menu in this Environment window, and name 
it “Sopranos” (or whatever), as in the image at the right. Go to the arrange page 
and create a new track. 
Control+click on it and re-
assign it to Clicks & Ports > 
Sopranos, as shown below. 
With this track selected, you 
see the track information on 
the left side of the Arrange 
window. (You may need to click on the small arrow next to “Sopranos” to drop-
down this information). Set the port to WordBuilder 1, channel 1.

6. From the Mixer environment window, select your PLAY Instrument track. Copy it 
into the clipboard (Apple + c). Go back to the “Clicks & Ports” environment page 
and paste the channel into the page (Apple + v).
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7. Draw a cable from the 
Physical Input port 
splitter where it says 

“WordBuilder 2.” Con-
nect this cable to the 
PLAY instrument track.

8. Record-enable the MIDI 
track in your arrange 
window and play the 
song! Make sure you are 
playing in the appropri-
ate range for the voice 
type selected.

9. Logic sends data to 
WordBuilder on these 
channels via Virtual 
WordBuilder Port 1, and 
receives the channel-
ized data back on Port 2, 
which is cabled directly 
to the PLAY.

10. Save this project as a 
template for future ref-
erence.

Creating the WordBuilder Voice
Once WordBuilder has been loaded into the host, the Voice Properties window opens. 
The MIDI input from the host is managed by the host; therefore, the Voice Properties 
dialog is much simpler than when opening Word-
Builder standalone. Name the voice, select the 
sampled voice you intend to use, and select the 
channel over which MIDI data will be output. Re-
member that WordBuilder may reserve 6 or even 
12 consecutive channel numbers for talking to the 
PLAY Engine. The Port and the MIDI In channel are 
selected in the host program.

Optionally, modify the Pitched Consonant and the 
Non-Pitched Consonant sliders to set how loud—compared to vowels—you want the two 
types of consonants to be.
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Data Flow
MIDI data entering WordBuilder is most often one MIDI note per syllable; the composer 
thinks in terms of the S, L, and Y sounds in “sly” being one sung entity. WordBuilder 
breaks the syllable into 3 notes (all at the same pitch) so that each can trigger its own 
samples. Many more MIDI events flow out of WordBuilder than flow in.

The following sections describe how WordBuilder gives you control over the various as-
pects of the outbound MIDI data so that you can shape the performance. For the most 
part you are working in terms of words, syllables, and letters, leaving it up to WordBuilder 
to translate your intentions into data the sample player can understand.

Setting Velocities for Letters
The incoming note from the sequencer or keyboard has a MIDI velocity parameter, and 
that velocity will be passed through to the various samples that the PLAY Engine plays; 
that is, unless you ask WordBuilder to change some or all of them. If the English word 

“fun” is being sung on a single note, there are three letters being played to enunciate the 
syllable; WordBuilder gives you the control to adjust the velocities on the Votox “F” and 

“u” and “n” separately.

Set the velocity for a letter by following the steps below:

Select the word by clicking anywhere in the word in the Time Editor; 
the flashing cursor will indicate the word has been selected. This step 
will display parts of the “fun” in the Word, Syllable, and Letter controls 
across the middle of the window, as shown below.

Select the letter you want to work on by clicking anywhere in the horizontal lane for that 
in letter the Time Editor. That will cause the lane to appear a little lighter than the oth-

ers. Make sure the letter also appears in the Letter display at the right 
end of the image above. The image at the left shows the Votox letter “F” 
selected in the Time Editor.

As you can see in the Letter control at the right 
in the image above, there are two  numerical set-
tings you can modify, labeled “ks:” and “v:” for 

“keyswitch” and “velocity,” respectively. For now, 
we are looking at the velocity, so click on the 3 dots (ellipsis) in-
side the small square to the right of the “v:” name. This will open 
the small dialog box you see at the right. The top half is shown here with the drop-down 
list of 6 possible operations open.
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Selecting Nothing leaves the note’s velocity unchanged, that is, leaves it the same as 
the velocity of the original MIDI note sent from the sequencer or keyboard. Selecting 
the equal sign sets the velocity to the exact value specified in the box at the right. For 
example, selecting “= 85” sets the velocity of the “F” segment to 85, no matter what 
the velocity of the played note is. Remember that values for velocity range from 1 (almost 
silent) to 127 (played with maximum force).

The other 4 symbols are the arithmetic operations plus, minus, times, and divided by. 
Consider an incoming note with velocity of 50. Here are examples of how the settings in 
this dialog affect the outgoing velocity for the individual segment.

VELOCITY ARITHMETIC
Setting in Dialog Box Result

+ 12 62

- 30 20

* 2 100

* 1.2 60

/ 3 17

All results are rounded to the nearest whole number between 1 and 127, inclusive. If 
you use these relative settings (instead of absolute instructions, such as “= 60”), it al-
lows you to change the velocity of notes in the sequencer or at the keyboard and have 
WordBuilder adjust the segments’ velocities proportionately.

Controlling Segment Transitions with Articulations
When setting lyrics, it is important to specify how the sounds flow into each other—or 
don’t. Singing the word “alone” might need to be noticeably different than singing the 
phrase “a loan,” even though the sounds of the letters are the same, and even though 
the notes on the staff are identical. As in all musical lines—instrumental or vocal—the 
performers need to make choices about how connected, or disconnected, the consecu-
tive notes should be. WordBuilder distinguishes between staccato and legato, as well as 
other styles.

Not only was each sung note recorded with all the various phonetic sounds, but also with 
four different attacks for each vowel:
•	 Normal
•	 Legato
•	 Staccato
•	 Slurred, Sliding

WordBuilder uses the concept of a keyswitch to move among these four articulations. In-
stead of writing extra notes in your score (as in EWQL Symphonic Orchestra) keyswitch-
ing can be managed with per-segment settings in WordBuilder.
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There are two ways to specify articulations: in a dialog box, or directly in the Text Editor.

AdVANCEd: Actually, there is a third way, more consistent with other PLAY libraries: You 
can send the keyswitch notes directly, instead of having WordBuilder translate your in-
structions into MIDI note events. The note numbers are 24, 25, 26, and 27 respectively, 
note names C0 to D#0.

To open the dialog, select the letter whose articulation you want to 
specify. This is done in the same way as in the previous section on 
Velocities. Then click on the 3 dots (ellipsis) to the right of “ks:” 
in the Letter control at the right of the WordBuilder user interface. 

In the image at the right, you can see it’s the same dialog box as 
for velocities, but here we use the bottom half. That means you 
can change both parameters at once, if you choose to. There are 
5 options available for keyswitches. Based on what you choose 
here, WordBuilder will send the appropriate keyswitch automati-
cally and at the right time. The choices are:
•	 [Text Syntax], use symbols in the text to specify the articulation of this segment. This 

is the default. (Look for more on this option below.)
•	 Normal Attack, the natural articulation of sung speech
•	 Legato, smoothly connected to the following syllable
•	 Staccato, disconnected from the following segment
•	 Slurred, Sliding Legato, a transition between segments in which the voices slide up-

ward into the note
Click “OK” to save your selection.

When the articulation in the dialog is set to “[Text Syntax],” which is the default, Word-
Builder looks to symbols in the Text Editor to know which articulation to use. There are 
4 symbols that can be typed anywhere in the text to affect the transitions:

TRANSITIONS
Symbol Articulation

= Normal

( Legato

> Staccato

< Slurred, Sliding

Here is an example of text whose articulation is specified with the Text Syntax symbols:
       “>the why and (where-fore >of the <mer-ry =day”

And the image below shows the same phrase in the Text Editor, but using the Votox let-
ters.



EAST/WEST QUANTUM LEAP SYMPHONIC CHOIRS VIRTUAL INSTRUMENT

  62Chapter 6: Using WordBuilder

As with all keyswitches, remember that each one continues to affect all notes (or, in this 
case, all segments) until a new keyswitch overrides the previous one.

Adding New Words and New Pronunciations
If an English word is not found in the dictionary, and you 
intend to use it again, then you can add the word and its 
phonetic spelling so that next time it will get translated 
automatically. When a word is shown in red inside the Text 
Editor (meaning that it is not found in the dictionary), right-
click on the word (in Windows) or control-click (on a Mac) 
to open the context menu, then select “Add to Dictionary.”

A dialog appears that lets you enter the Phonetics layer for the 
word (not Votox). Do not type in hyphens to separate syllables.

The same facility can be used to add new pronunciations of ex-
isting words. This way, you can even teach your choir to sing in 
regional accents. Although, you need to be careful not to over-

write a traditional phonetic spelling if you may need the traditional pronunciation again. 
You might consider making up your own “English” spelling of words in a specific dialog 
and then provide the phonetic spelling for WordBuilder to use.

This facility can also be used to some degree to teach the WordBuilder program some 
words from other languages, but be aware that only English phonemes are available, so 
you will have to use approximations for many non-English sounds.

Soloing a Word
Sometime when you’re making changes to the sounds of a word, you would like to hear 
it over and over while you tweak the settings. You can do that with the operation known 
as “soloing.”

In the Word control at the left side of the WordBuilder 
window is a button named Solo. Click on that button 
while the cursor is within the word in question. The 
word will turn to red to indicate it is soloed, and the 
button will turn light blue. 

Now every time you send notes into WordBuilder it will cycle through only this one word. 
If playing the word with a sequencer, you can set the sequencer to loop through only the 
appropriate notes.

Click on the same Solo button to turn off soloing.



EAST/WEST QUANTUM LEAP SYMPHONIC CHOIRS VIRTUAL INSTRUMENT

  63Chapter 6: Using WordBuilder

How WordBuilder Learns Timings
When you first type text into the Text Editor, WordBuilder uses default lengths for each 
sound that makes up a syllable. As was shown in the example on page 38, WordBuilder 
assigns the “ee” of “sweet” to start at about 175 milliseconds after the start of the note. 
But if the tempo is fast, the note could be over by then, or the “sw” could take up most 
of the note’s duration, making it sound unnatural. You could, of course, compute the 
number of milliseconds for each note and adjust the lengths of the sounds manually. But 
there’s a much easier way.

The Learn button opens a dialog box where 
you can set two options. The first option 
specifies whether you want WordBuilder 
to adjust the duration of the phonetic seg-
ments, called Change Speed mode, or only 
to indicate the length of each syllable in 
the time line at the top of the Time Editor, 
called Draw Only mode.

With the second drop-down list, you spec-
ify whether you want WordBuilder to learn 

durations for all voices or only the currently selected voice, as shown below.

Once you pick the options you want and click 
on Start, another dialog box opens and asks you 
to start the melody. Begin playing the notes for 
this part, whether from the sequencer or the key-
board. WordBuilder keeps track of how long the 
note for each syllable lasts. When the color in 
the progress bar fills it completely, WordBuilder has received as many notes as there 
are matching syllables. Click on OK to return to the program’s main interface. Cancel 
discards the learned information.  

If you asked WordBuilder to Change Speed on the notes, then the horizontal bands that 
represent each phonetic sound’s duration (in milliseconds) will change. Consider lyrics 
that include the word “sleep.” Before the learning process, the Time Editor looks like 
this.

After learning, the timing of the five phonetic segments is quite different. In the time line 
at the top, the lighter blue interval is the duration of the note itself. The dark red interval 
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is the time for singing the consonants and glides that close the syllable. In our example, 
this takes place in the sixteenth note rest. The very dark blue-black shows where the 
next note starts.

In this example, the syllable is sung on a dotted eighth note with a six-
teenth note rest before the next note. The tempo is 90 bpm. (If you do the 
math, you’ll see that the duration of a dotted eighth at 90 bpm is 500 ms, 

which agrees with the image.) The staff at the left shows this configuration.

Setting the words to quarter notes with no rests between the notes would yield similar—
but not identical—results. Here the “p” that closes the syllable occurs during the rest. 
With no rest between notes, all the phonetic segments happen within the duration of the 
note itself (or might intentionally overlap the start of the next note by a small amount). 
When writing a score for real singers to read, simplicity of the notation is important, but 
in WordBuilder and Symphonic Choirs fine-tuning the duration of the MIDI notes by 10 
or 20 ticks can have an impact on the sound of the syllables. When trying to fix a syllable 
that doesn’t sound quite right, ask yourself whether lengthening or shortening the rests 
between notes can improve the result.

Click on each word in the Text Editor to see how WordBuilder has modified the timings 
of all the segments to match the music to which the phrase will be sung.

Once WordBuilder has “learned” the note-on and note-off events of a musical line, you 
can manually tweak the timings to fine-tune the performance.

If you change the tempo or the note durations, you may want to rerun the “Learn” fea-
ture to conform the phonetic segments to the shape of the new melodic line. Changing 
pitches does not require rerunning “Learn.”

Draw Only Mode
If you choose Draw Only mode when starting the “Learn” feature, WordBuilder writes the 
length of notes and rests into the gray, red, and blue regions of the timeline at the top, 
but does not change the actual lengths of the phonetic letters (the colored bands next 
to each phonetic letter in the Time Editor). You can manually drag the ends of the bands 
to achieve the desired effect.


sleep

  
no

  
more.
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The above screen shot shows the Time Editor for the syllable “sleep” after running Learn 
in Draw Only mode. No manual adjustments have been made to individual segments. 
The 3 colors in the time line have the same meaning as in Change Speed mode.

The last two segments are still timed to the Note Off event, as seen by their position in 
the rightmost pane. If you want them timed to the Note On event, then drag them into 
the left pane. Their timings will change from negative values to positive ones. Use the 
bands within the time line so you know where you’re placing segments in relation to the 
end of the current note (beginning of the dark red) and to the start of the next note (end 
of the dark red).

Whether to Use “Learning”
This “Learn” function is a way to automate some of the precision work needed to adjust 
letter timings to match note durations. It does not achieve with a single mouse-click 
perfect enunciation of the sung letters; you still need to listen to the result and fine tune 
the performance.

Because Draw Only mode makes no changes to the output, it can provide information 
about how the notes’ timings relate to the default letter timings within the syllables. 
Even for those who prefer to adjust the timings of the phonetic segments themselves, 
this extra information can be useful.

Change Speed mode provides the greatest benefit when used on fast-moving music, 
where the default durations of phonetic segments may not have time to play out before 
the notes end.

Making Changes to “Learned” Text
To remove all modifications made by the “Learn” feature, place the cursor in the syllable 
you want to revert to its default timings—or select several syllables—and then choose 
Normal in the Syllable Speed dialog (shown below). This action has the side effect of 
removing any change you made to the affected syllables, the same as if you deleted the 
syllable and then re-added it.

Other Ways to Adjust Timings
In the Syllable control of the WordBuilder interface, directly below the Learn button, is 
a field marked “Speed:” with 3 dots (ellipsis) to the right. Clicking on the 3 dots opens 
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a dialog box for adjusting the speed of the selected syllable (by adjusting the duration 
of its segments).

There are three options to choose from. The first, “Normal: 
Hold on first vowel” lets you use the default settings. That 
is, it removes any adjustments previously made to the syl-
lable. It also removes any Control Changes that had been 
applied. It has the same effect as removing a syllable and 
adding it in again.

The second option, “Learn: Compress/expand by learning,” 
is grayed and not available unless the “Learn” functionality has already been applied to 
this syllable. It is useful when a syllable has been “learned” in Draw Only mode. Select-
ing this option and clicking Okay completes the action that would have been done had 
Learning been done in Change Speed mode. You might also use this after changing a 
word in the text (leaving the notes as they are but changing “nice” to “sweet,” for ex-
ample) and you want WordBuilder to learn timings for the new phonetic segments.

The third option is Adjust Speed. If selected, the controls below it become active. In the 
left drop-down list, you can choose whether to apply changes to only the On pane, only 
the Off pane, or both panes. The right text box allows you to enter a number that speci-
fies how long the new notes should be, compared to the old. Setting it to “50%” cuts all 
lengths in half. Setting it to “250%” makes all durations 2.5 times as long as before; a 
bar that beforehand lasted 80 ms now lasts 200 ms (80 times 2.5).

For each syllable in the Text Editor window, the Syllable section 
lists its speed in the UI. After the word “Speed:” appears one of:
•	 Normal, if the default lengths are still in effect
•	 Learned, if the lengths have been learned from either the Learn 

button or the Syllable Speed button
•	 Edited, if lengths or start times have been modified with the mouse
•	 Adjusted, if the Syllable Speed dialog box was used to “adjust” the lengths

Resetting the Syllable Cursor
As WordBuilder receives each note event, it has no way of knowing whether the se-
quencer is playing the next note in the musical phrase or the melody has been restarted. 
WordBuilder always makes the assumption that it is being requested to sing the next 
syllable unless it receives a Reset command.

There are three ways to tell WordBuilder to start again at the beginning of the text:
•	 Click on the Reset Position button in the array of buttons in the upper-right corner of 

the window.
•	 Select Reset Position from the Voice menu, or press the F5 key. (Menu options are 

only available in standalone mode.)
•	 Send a MIDI message; see page 77 to learn how to specify the message WordBuilder 

looks for.
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In either case, the Reset command performs three actions:
•	 repositioning the syllable cursor to the beginning of the text
•	 resetting any open keyswitch files back to “normal attack,” the default keyswitch (C0)
•	 resetting the Mod Wheel to a zero value

It is also possible to reset the cursor to anywhere you want in the text. Use the mouse to 
position the cursor in the syllable you want to start with. Then select Reset Position to 
Text Cursor from the Voice menu, or press the F4 key.

Using Built-in Cross-Fades
The EastWest / Quantum Leap Symphonic Choirs includes cross fades in some of its cho-
ral “instrument” files. These are voice files that respond to changes in the Mod Wheel by 
changing the mix between two contrasting sets of samples. You can use WordBuilder to 
simulate turning the Mod Wheel at specific times during a performance, thereby dictat-
ing which of these samples predominates and by how much.

Changes to the Mod Wheel are transmitted using MIDI Control Change 1, also called 
Control Code 1, either way abbreviated CC1. WordBuilder lets you set up envelopes that 
transmit via any Control Change number, though you will probably only use a few num-
bers in this context.

Here is an example of how cross-fades are useful. The “Full” Soprano voices are used 
in this example, but this functionality is available in all of the vocal ranges and in all 
3 mic positions. The vocal file named “SOPR WB HARD MOD” uses the Mod Wheel to 
move smoothly from a value of 0 (medium volume, medium vibrato samples) to 127 
(loud, heavy vibrato samples). This cross-fade can create realistic swells—either within 
a note or over a phrase—in which more vibrato is added at the same time as the volume 
increases.

To send Mod Wheel Control Changes you first 
need to set up an envelope on any phonetic 
segment affected, which usually means on a 
vowel. Click on the small plus sign to the right 
of the Votox letter in the Time Editor. A new 
lane will open with a button for selecting the 
Control Change number. The default setting is 
Volume.

Click on the hyperlink titled “Vol.” to open the 
small dialog in the image at the right. Select 

“1 - Modulation Depth” from the drop-down list. 
Click on OK to effect the change. The orange 
link now says “CC 1.”

There’s a graph inside the long box to the right, 
as shown in the image after this paragraph. 
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You can drag nodes with the mouse and create new nodes by double-clicking with the 
left mouse button. (You can also delete nodes by double clicking with the right mouse 
button in Windows, or double-clicking with the Command button held down on the Mac.) 
Add as many nodes as you need to draw in the desired changes.

It is unlikely that you will want to draw complicated curves (like the one above) inside 
a single phonetic segment (unless the choir is holding the note for a very long time). 
Instead, you will probably be matching the position of the Mod Wheel as the choir pro-
gresses from one note to the next.

When dragging a node, a small rectangle, called a tool tip, opens on the screen. The x 
and y values locate the exact position of the node as it moves. The x-coordinate locates 
the node in time, measured in milliseconds. In the accompanying screen shot, the x-
value is 224 ms. If you see negative values that only indicates that the time is in the 
right pane, and so do not signify a time before 0 ms. 

The y-coordinate specifies the value of CC1 on a scale from 0 to 127. In the screen shot, 
the node in the upper envelope is being dragged with the mouse (not visible in the im-
age). The Mod Wheel at the third node is at a position of 46, about 36% of the maximum 
127.

You can use these y-coordinates to match the position of an envelope at the end of one 
phonetic segment to the position at the start of the next one, if desired.

It’s also possible that you may want to set the position at a fixed value and leave it there. 
For example, if you like the sound of the tenors at a Mod Wheel position of 40 in the 
TENR WB SOFT MOD instrument, then you can set it to that level consistently. But be 
aware that you will get more realistic results if nothing in a performance remains static 
for too long. Real choirs never retain an exact dynamic or a consistent level of vibrato 
over every note in a composition.

Other Envelopes
You can use the techniques described above to create continuous changes in other MIDI 
parameters as well. Any Control Change can be transmitted, but if the downstream MIDI 
processors don’t respond to that CC, then nothing will happen.

Expression, CC11, is the best way to change the short-term dynamics that shape the 
singers’ nuanced performance. Small swells within a single vowel or a natural decre-
scendo at the end of a long-held note can be important in making the final results feel 
more human and less like computer-assisted composition.

Click on a plus sign to open a lane for a new envelope. Click on the minus sign to remove 
that envelope and its lane.
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Note Volume
One envelope that warrants special mention is the one that appears at the top of the 
drop-down list: “x - Note Volume.” This parameter affects the given phonetic segment 
without affecting others. It can be used for fade-in and fade-out effects within a single 
phonetic letter.

It can also be used to achieve cross-fades between phonetic elements. This use of Note 
Volume can be seen in some of the default Votox spellings.

The sound of the long “i” in the English word “might” is spelled as “aE” in Votox. As is 
shown in the image above, WordBuilder knows that the process of closing the syllable 
consists of moving the tongue in a way that smoothly changes from the “ah” sound of 
the held vowel to the “ee” sound at the end. This is achieved by fading out the “ah” and 
fading in the “ee” until the “ah” sound is complete replaced with the “ee” sound. The 
two envelopes in the screen shot implement this cross-fade. You do not have to create 
these envelopes yourself; WordBuilder does it automatically for you for the standard 
diphthongs of English. But you may have to adjust the duration and slope of the enve-
lopes to achieve the sound you’re looking for.

Using a Library of Phrases
If there are phrases you plan to use more than once, WordBuilder 
provides a way to store in a phrase file on the hard drive all the in-
formation about the phrase (phonetic letters, timing, cross fades, 
and so on). The phrase can then be quickly recalled each time it’s 
needed without having to reconfigure all the settings.

Included Latin Phrases
WordBuilder includes a selection of Latin phrases in two folders. If you need to use one 
of them, open this menu and find the phrase in one of the folders. You may need to ad-
just the timings and other features to suit your piece, or you may be able to use it as is.

Adding Your Own Phrases
If you have created phrases in another project, and want to import them into your list 
of stock phrases locally, click on “Add to Phrases (from File)” in the pop-up menu. You 
will be prompted for a Voice file (extension .voi) or Choirs file (extension .cho) that was 
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exported at an earlier time from WordBuilder). Once you open a file, the Add Phrase 
dialog appears, allowing you to name the phrase and indicate the folder where it should 
be stored. You can also specify whether the phrase is for only the original voice type or 
all voice types. The entire contents of the Text Editor in the opened file is stored as a 
new phrase.

You can also create a new phrase file from the 
current contents of the Text Editor by selecting 

“Add Phrases” from the pop-up menu. The proce-
dure is the same as in the prior paragraph except 
that you are not asked to select a file.

Organizing Your Phrases
If you select “Organize Phrases” from the pop-up 
menu, a file system explorer opens, allowing you 
to move files and folders to create whatever folder hierarchy you want for your phrases.

Loading Phrases into the Current WordBuilder Project
Hover the mouse over one of the folder names at the 
bottom of the pop-up menu to see the phrases and sub-
folders inside that folder. Select whatever file you want 
to include in your current project, and it will appear in 
the Text Editor control, starting at the mouse cursor.

Notes from the Producers
This software was an enormous undertaking, but it is not something we plan to release 
and then forget about. Please check the EWQL forums at
     http://www.soundsonline-forums.com
for a forum called “Symphonic Choirs/WordBuilder.” Here you can find hints and discus-
sions about WordBuilder and it’s where to get the most from this software.

Hints
We want to mention a few things about the choir samples that may not be obvious. These 
hints will, we hope, be the sort of thing you will be able to find being posted on our forum, 
so please contribute there anything you find that may help others.

Hint 1: Normal Attack and Legato Attack vowels in the 4 adult choirs all have a hard, 
staccato accent that kicks in at velocity 102 and above. This means that independent of 
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everything else, if you hit the keys hard, you will get a strong attack. This can be very use-
ful for fast, accented passages. When writing smooth lines, avoid these hard velocities.

Hint 2: Unusual and non-English vowel or consonant 
sounds can be created by layering vowels or consonants 
in WordBuilder. For example: the French word “Louvre” 
can be created in Votox with this text:
 lOU vrgU
In the first syllable overlap “O” and “U” so that they 
play together until note off. (To accomplish this overlap, 
drag the ends of the horizontal bars in WordBuilder’s 
Time Editor.) In the second syllable, overlap “r” and “g” for a French R.
Experiment to find your own combinations and post what you find on the WordBuilder 
forum.

Hint 3: The Latin word “maximus” can be written either like this in Votox:
 maX E mOS
or like this:
 maX SE mOS
In the second example, the S-sound at the end of the “maX” syllable gets connected 
to the next syllable because the S-sound is triggered again at the beginning of the next 
syllable.

Hint 4: Many words work better if you repeat the first vowel twice. The word “drum” is 
usually written like so in Votox:
 drum
But it can also be written like so:
 druum
Now, when you let go of the note, “u” is triggered again for a short period of time before 
the “m.” You can overlap and cross-fade the second “u” and the “m” for a smooth re-
alistic effect.

Hint 5: Consider a word like “rain,” which can be written like so in Votox:
 reEn
The realism of the vowel sound can be enhanced by adjusting the curve on the “eE” 
cross-fade. Have the “e” decrease from 127 down to y=50, instead of near 0. This detail 
makes for a more convincing diphthong.

Hint 6: Generally, the slurred legato is best for a rolling legato line. The regular legato 
is good for fast, clean connected notes. The legato attack is the least natural and most 
perfect sounding of all the attacks. In the Boys choir, the normal attack has a lot of the 
character of the boys and the legato attack is more perfect and synthetic. Nice lines can 
be created by mixing the two styles: Normal, Legato, Legato, Legato, Normal, Legato, etc.

Hint 7: When consonants are even slightly too loud, it can sound unnatural. Real choirs in 
a hall are hard to understand. Consonants that are too soft are preferable to consonants 
that are too loud.
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Hint 8: Use the Mod Wheel and CC11 for expression. It really helps. See the sections 
starting on page 85 for more details.

Hint 9: The preset, default relationship in volume between the vowels and consonants in 
all the multis is supposed to be consistent. That means that if you load the soft multi 
and create some text, then decide to switch to the hard multi, the vowel consonant re-
lationship should be the same. In reality, though, there may be slight differences. For 
this reason, we recommend that you don’t do any final tweaking in WordBuilder until you 
have loaded the multi you plan to use in the final version.

Hint 10: If your choir is sounding fake:
Maybe you need to leave more space between consonants, or perhaps make each con-
sonant longer.

Try overlapping certain consonants and possibly cross-fading them.

Sometimes legato attacks can make things sound better or worse. Sometimes you need 
to use slurred legato on the vowel to improve a consonant-vowel transition.

Sometimes an accent on a certain syllable is crucial to realism. Hit the keys hard for an 
accent.

Sometimes it’s a good idea to fix MIDI velocity in your sequencer at a single value. This 
can improve smoothness and make editing in WordBuilder easier. Use CC 11 and the 
Mod Wheel to inject dynamics.

Hint 11: We really recommend using Votox exclusively. Once you get good at sounding 
things out and you learn the letter symbols, it’s powerful stuff.
Look for more hints like these—and contribute some of your own—in the “Symphonic 
Choirs/WordBuilder,” section online at:
 http://www.soundsonline-forums.com

Enjoy, Nick Phoenix and Doug Rogers
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The WordBuilder Options Dialogs
Among the buttons at the right side of WordBuilder’s window is one named Options. 
Clicking it, opens the dialog box shown below. From here you can change a number of 
parameters that affect the ways the program operates.

The General Tab
The first drop-down list on this tab, Sound Library, defines the library of samples that 
generates the sounds. At the time of this writing, EastWest/Quantum Leap Symphonic 
Choirs is the only library available.

In a second drop-down list, called Language, you 
can specify from what language the dictionary will 
translate to Phonetics. The only dictionary available 
at this time is English.

There are two modes in the Vowels drop-down list: 
English Mode and Latin Mode. They affect the sym-
bols used for Votox sounds, but do not affect the 
sounds themselves. See page 94 for more information 
about these two modes, when to use each of the two 
modes, and charts comparing the two sets of vowels.

The Timers Tab
The upper section of this tab, Timers Resolution, provides two slider controls. For Notes, 
you can set the resolution to any value between 1 and 10 milliseconds.

A similar setting can be made for the resolu-
tion of Control Changes: any value between 
10 and 50 milliseconds.

Fine-tuning these two settings allows the 
user to specify how often the internal engine 
will convey note and Control Change data 
through the MIDI output. You should nor-
mally leave these settings at the minimum 
value, but they can be raised when it is nec-
essary to conserve CPU processing or MIDI 
connection overhead.
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For example, when a cross-fade is in progress the ear cannot really hear a small change 
in dynamics every 10 ms. Therefore, Note Volume (and other CC) data can be sent less 
often to conserve the processing power in the computer.

The Chord Timer, set at the bottom of the tab, permits the user to specify how far apart 
in time notes can be and still be considered a chord (that is, referring to the same syl-
lable of text). Using this feature is especially helpful when playing melodic lines on a 
keyboard in real time. If you’re not 100% accurate in hitting all the notes of a chord at 
once, you could end up triggering different syllables for what are supposed to be several 
voices singing the same syllable. You can turn this feature on and off by clicking on the 
small checkbox at the left and, when on, you can specify the tolerance in milliseconds. 
You can turn this feature off if you never use chords in a single choral voice.

If you need to leave this feature on, then you may have to experiment to determine the 
value that works best for your playing style.

The Voices Default Tab
There are three dialog boxes that open from 
this tab. Each is used to set the defaults that 
first appear when those dialog boxes are pre-
sented. If ever you want to change the val-
ues that you have set in these dialog boxes 
to apply to a specific project, you should do 
that in the project-specific dialog boxes, not 
here. Details of this process are presented in 
the paragraphs below.

Default Voice Properties Dialog Box
This is the same dialog box that appears 

each time you start WordBuilder in stand-alone mode. If 
you never set values as the defaults in this dialog, then you 
will always see the same values as shown on page 50. But 
let’s say you always use your keyboard to play the melo-
dies, and always transmit on MIDI channel 9. Then you 
can preset those choices (and others) here and not have to 
reset them every time you start the program.

The screen shot at the left shows these values entered into 
the Default Voice dialog box. And this dialog, filled in the 
same way, is exactly what then appears each time you start 
WordBuilder.

Important: you must save the current choir file before these 
choices become the working defaults.
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Default Voice Advanced Midi In
Clicking on the button with this name opens a dialog 
where you can set values for the current voice. Changes 
made here will become the default values once you save 
the choir file.

The two Limit Notes controls specify the bottom and top 
notes that can be accepted. Change these values if you 
expect to generate notes in the normal vocal range that 
you want to exclude from EWQLSC. Making the range 
wider has no effect on the generated track (because there are no samples recorded for 
notes outside the original range).

Note that these values are not based on the currently selected voice type. You are set-
ting the default value for the default voice, Sopranos. When you create a new voice file, 
Sopranos always appears as the default in the dialog box, and the range you set here is 
the default range for the Sopranos.

The original defaults for the choral voices are listed below. And one of these is what will 
be set when you select the voice type you want.
•	Sopranos    D3 [62] to  E5 [88]
•	Altos    F2 [53] to  A4 [81]
•	Tenors    C2 [48] to  D4 [74]
•	Basses    B0 [35] to  D3 [62]
•	Boys    C3 [60] to  B4 [83]
•	Women    F2 [53] to  E5 [88]
•	Men     B0 [35] to  D4 [74]

The Transpose drop-down list allows the user to shift all notes that arrive from the MIDI 
In Channel by a specified amount when sent via MIDI Out to the PLAY engine. Possible 
values are:
•	Up 2 octaves
•	Up 1 octave
•	No transpose
•	Down 1 octave
•	Down 2 octaves
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Once the choir file has been saved, these defaults remain in effect unless changed in the 
Voice Properties dialog box that is opened:
•	by clicking on the vertical rectangle near the upper left corner of the WordBuilder 

window
•	each time a new voice is created

Default Voice Advanced Midi Out
To understand what this dialog box does you have to know that each voice in WordBuilder 
connects to the PLAY engine running Symphonic Choirs over 6 separate MIDI channels. 
Here you can set the default values for both the port and the channel over which the 
MIDI data is sent. Under normal circumstances, you do not need to set these values, 
but advanced users can control the parameters to accommodate special circumstances. 

In the seventh drop-down list, you can select 
the port over which to send any other MIDI 
data. The last control lets you specify a differ-
ent channel to accept the data stream when the 
Bypass button in WordBuilder is turned on.

The Events Tab
The fourth tab in the Options dialog box lets 
you set event triggers—MIDI messages—that 
control the position of the performance cursor 
while the vocal lines are being played.

At the top of the tab, you can specify the MIDI 
Control Change code (and its value) that will tell WordBuilder to reset the syllable cursor 
to the beginning. This MIDI event is the way for a sequencer to tell WordBuilder that it 
has stopped and gone back to the beginning. For example, without this setting, if you 
played the first 4 measures, stopped the sequencer, then started again from the begin-
ning, WordBuilder would pick up at the words from measure 5.

The default setting is CC20 with a value of 127. 
It is recommended that you insert this message—
or whatever you change it to—before the first note 
in your sequencer (in all channels connected to 
WordBuilder voices). That way WordBuilder always 
knows when the sequencer starts over. If you need 
to, check the documentation for your sequencer to 
find out how to add such a message to the event list.

In this dialog, you can reset the default to any CC 
code, but if you do change it, it is recommended 
that you use one of the unused codes. The drop-
down shows you not only the numbers of the codes, 
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but their usual meaning as well. Those with names that include “General Purpose” or 
“Control” are unassigned and good choices.

The lower half of the tab allows you to specify CC codes and values whose meaning to 
WordBuilder is to start holding the syllable and stop holding the syllable. If you want the 
“ee” sound of the word “sweet” to hold over five notes, send the Hold On event from the 
sequencer before the “ee” has started on its first note, and send the Hold Off event after 
the start of its fifth note.

 
The


sweet

    
sound
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Using Symphonic Choirs in PLAY
The EastWest/Quantum Leap Symphonic Choirs Virtual Instrument (to use its full name) 
comprises two main parts: WordBuilder and the PLAY software that actually creates the 
sound of the phrases set up in WordBuilder. The last few chapters have been devoted to 
WordBuilder. This Chapter turns the focus to PLAY.

Playing Music with Symphonic Choirs
This section of the manual describes how to take advantage of the musical and techni-
cal features of this sound library to create choral music that is expressive, varied, and 
realistic. Without this control of the available parameters, music created on a computer 
can sound static, lifeless, and dimensionless. Using the features described below is akin 
to a singer controlling dynamics, phrasing and technique to interpret the music. In other 
words, there’s more to music making than perfecting the pitch, loudness, and duration 
of each note.

Instruments and Multis
The various “instruments” in Symphonic Choirs fall into 
two types:
•	 Individual instruments: these include both soloists 

and selections of choral sounds that cannot be used 
with WordBuilder to form sung phrases

•	 Multi-instruments: these are the choirs in 7 different 
voice types that work with WordBuilder

See the chapter that describes all these instruments and multis starting on page 99.

Full SATB Choirs: 2 Approaches
There are 2 standard ways to create a full choral sound with EWQLSC. They trade off the 
speed with which you can achieve your results against the realism of the final recording. 
Another deciding factor may be how demanding each approach is in its use of computer 
resources.

One: For the most realistic results, use one of the complete multis for each part: Sopra-
nos, Altos, Tenors, Basses, and Boy Sopranos. As with live singers, the five ranges over-
lap. This gives you the flexibility to create vocal lines in which, for example, Sopranos 
maintain their distinctive timbre in every part of their range, even below the top of the 
Altos’ range.
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This approach can use so many computer resources that it’s unlikely you can record all 
4 lines at once on a single machine; you may have to split your parts across two or more 
computers, or else “freeze” some lines to audio while playing the samples for other lines.

Two: For a more homogenous sound, EWQLSC provides “Full Men’s” and Full Women’s” 
Choruses. The voices in these multis are range-limited, meaning there is no overlap be-
tween the Sopranos and Altos, and also none between the Tenors and Basses. If a single 
vocal line passes the split point, the samples change from, for example, Tenors to Basses. 
If that’s not a problem in your project, then this approach is a good choice.

You’re still using WordBuilder, so you have all of its power at your disposal. In addition, 
the computer resource requirements may be reduced enough that you can load the entire 
SATB Choir in a moderate amount of RAM.

The Soloists
Three soloist voices are provided: soprano, alto, and boy soprano. Like the choirs de-
scribed above, the soloists are available in all three mic positions. The soloists are not 
available from WordBuilder.

Cross-Fades and the Modulation Wheel
A cross-fade uses two or more different samples on the same MIDI channel and provides 
a means to lower the volume of one sample while simultaneously raising the volume on 
another sample. This fading between the two sample creates a smooth transition from 
the sound of one to that of the other.

In EWQLSC, the Mod Wheel controls cross-fades that affect the sound of the virtual sing-
ers. The parameters controlled include the amount of vibrato and the dynamics.

The basic Choirs package (without the optional Choirs Expansion) provides three types of 
cross fades in the choir multis:
•	 DYN MOD (3-way dynamic modulation): an all-in-one collection of dynamic range.
•	 SOFT MOD (2-way soft modulation): the lower end of the dynamic range in DYN MOD. 

From soft volume without vibrato to medium volume with vibrato.
•	 HARD MOD (2-way hard modulation): the upper end of the dynamic range in DYN 

MOD. From medium volume with medium vibrato to loud volume with heavy vibrato.

The first of these gives you the most flexibility to adjust volume with 
the Mod Wheel through the entire gamut of recorded dynamics, so 
it requires the most computer power and resources. The other two 
options use less memory and, therefore, may be better choices on 
hardware-constrained systems.

There are, of course, other ways to control dynamics, including MIDI velocity and expres-
sion parameters. (These controls are discussed later in this chapter.) There are two main 
advantages of dynamic cross-fades (DXFs) over other means.
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First, a DXF controls not only the volume, but also the timbre of the sound. The sound of 
a soprano section singing loud is different from them singing softly, even if the volume 
knob on the stereo is adjusted to normalize their output level. Because a DXF is shifting 
between samples and not only changing the volume, that change in timbre is preserved. 
As mentioned above, the vibrato also increases as the volume goes up.

Second, unlike velocity, which is fixed for the entire duration of any MIDI note, the posi-
tion of the Mod Wheel can be adjusted continuously to achieve swells and other expres-
sive details mid-note.

Segment Transitions and Keyswitches
The samples of the sung vowels are available in 4 versions (except for the boy sopranos, 
which use only two). The difference among them refers to how segments transition from 
one to the next:
•	 normal attack
•	 legato
•	 staccato (not with boy sopranos)
•	 slurred, sliding (not with boy sopranos)

When using WordBuilder to drive the choir multis, the transitions can be specified either 
with one of the 4 symbols “=(><” inside the typed text or by selecting properties from a 
dialog box. See page 60 for more details.

When loading individual vowels, the segment transitions are managed with keyswitches. 
The file names for the adult-sung vowels end in “C0-D#0” to indicate there are 4 key-
switches: C, C#, D, D# in the C0 octave. For the boy soprano files, the “C0-C#0” shows 
that only the first two keyswitches are available.

A keyswitch is a note out of the range of the singer that can be added to the MIDI output 
to specify which version of the sample to play. PLAY interprets the keyswitch and plays 
the correct sample.

WordBuilder generates keyswitch notes automatically; therefore, WordBuilder users will 
likely never use the manual keyswitches there. (They are, however, used extensively in 
the soloist files.)

AdVANCEd: When playing the individual vowel programs, if you want to use this feature it 
must be done manually. You can include the keyswitch note a little before the Note-On 
event of the first note to play the associated version. That version will continue to be 
used until another keyswitch changes the setting. If you want to accept the default set-
ting, “normal attack,” for all notes, then no keyswitch notes are necessary.

Performance Scripts
Symphonic Choirs includes three built-in scripts that can provide extra realism to phras-
es that take advantage of their benefits:
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•	 The Portamento script provides a sliding pitch between consecutive notes in a phrase. 
This can be used to emulate the subtle portamento that occurs, for example, when a 
singer’s voice moves upward or downward toward the next note at the end of a sound-
ing note (but not a full glissando).

•	 The Repetition script changes the quality of the notes when a single pitch is sung 
multiple times in quick succession. Although similar to what can be achieved with the 
Round Robin patches found in other EastWest and Quantum Leap libraries, the effect 
here can be used on any articulation.

•	 The Legato script creates a more flowing and connected sound for notes in a continu-
ous phrase.

Note that this Legato script mentioned here is not the same as the Legato attacks de-
scribed earlier, starting on page 60. They have a different sound and can be used sepa-
rately or together. Try experimenting with both to see what works best in your project.

The scripts themselves are not modifiable by the user, 
but one important parameter can be adjusted using a 
MIDI control code. See details of how to use the con-
trol codes in the descriptions that follow.

In order for a script to actively affect the notes in an articulation file, the script must be 
activated in the PLAY user interface. The image above shows two of the scripts turned on 
and the Repetition script left off. In addition, the appropriate MIDI Control Code must 
not be turned Off; that means if MIDI values are being generated for the On/Off code 
on this channel, as in the table below, they must currently be in the range 64 to 127; if 
MIDI CC values are not being generated, the Control Code is considered On (as long as 
the light in the user interface is On).

The effect of engaging the Portamento or Legato effect is subtle. The goal is the sound 
of smooth, connected playing and not anything so pronounced that it will draw attention 
to the effect itself. These two scripts share many features in the ways they affect the 
sound; that is, the Legato script includes a small portamento component and vice versa.

MIDI Control Codes
These MIDI values can be controlled in standalone mode by adjusting the controls (knobs 
or sliders) on a “control surface” or MIDI keyboard. When run as a plug-in inside a se-
quencer or other host, you can create a controller envelope to automatically adjust values 
during playback. See the documentation from your hardware or software for information 
about how to change the values of control codes.

The following table lists the codes that affect these scripts. Note that the MIDI Control 
Codes have no effect unless the corresponding script is turned on in the PLAY interface.
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Code Portamento Repetition Legato
5 Time Time
65 On/Off
68 On/Off
69 On/Off

The three On/Off control codes all work the same way: a value 64 or higher turns the 
script on and any other value (0–63) turns the script off.

CC 5 affects the duration of the portamento or legato. The possible values are 0–127. 
The higher the value the longer the effect takes to complete; that is, you should set 
higher values to make the sound more pronounced. Use your ear to find the right values 
for each note in the phrase. 

The image at the left shows two envelopes affecting the Portamento 
script in a host. The nine white horizontal bars are the notes. The light-
gray line that jumps from the top to near the bottom and back to the 
top is CC 65 that turns the script on and off so that only some notes 
use portamento. The curving line near the middle is CC 5, setting the 
effect’s “Portamento time” parameter for each note individually. (Note 
that the middle section, when the CC 65 line is near the bottom, CC 
5 actually has no effect because the script is turned off at that point.)

Monophonic Behavior
Both the Portamento and Legato scripts change the instrument (.ewi file) so that it can 
play only one note at a time whenever the script is turned on. If a note is still playing 
when a new note starts, the first note will end at that moment. This behavior allows for 
no ambiguity in how the notes form a phrase.

One consequence of this behavior is that if you want two concurrent legato lines—or one 
legato and one non-legato line—sung with the same voice, you need to open the same  
voice type more than once and turn on the Legato script where appropriate. Of course, 
the same rule holds for the Portamento script.

Release Trails with Legato and Portamento Scripts
When either of these two scripts is turned On, release trails for that articulation are 
automatically turned off. To leave them on might interfere with the portamento and/or 
legato effect.

Because the release trails will be turned off, you may then want to turn on some reverb; 
the choice of one of the “EW Hall” convolution reverbs in the PLAY engine will most 
closely match the natural reverb of the rest of the library.
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Repetition Script
When singing consecutive notes of the same pitch, the use of a single sample over and 
over in quick succession can sound mechanically identical, which is called the “ma-
chine gun effect.” The Repetition script solves this problem. For any voice file, this script 
uses one or more of three randomly selected options to keep the sound a little different 
on each repetition:
•	 Use the sample for a nearby note (for example, a half step higher or lower) and retune 

it to the needed pitch.
•	 Start the note a tiny amount before or after the specified start time.
•	 Detune the sample a few cents (hundredths of a semitone) higher or lower.
This variability gives the sound a more human, less robotic, feel. After all, what human 
sings every note exactly on pitch and at exactly the notated time?

The EWQLSO producers have selected which of these three approaches will be used for 
each vocal patch—and how much variability to allow—to achieve the most realistic be-
havior. That is, some patches randomly use all three approaches, while others may use 
only one or two of them.

Volume, Velocity, and Expression
There are at least four ways to make sampled voices sound louder, or at least make the 
real notes seem to have been sung louder. One of these, the dynamic cross fade, was 
discussed on page 81 above.

Volume is just the loudness of the generated sound. Changing volume is basically the 
same as turning the volume knob on your audio system. A soprano singing softly can be 
cranked up; a soprano belting a note can be turned way down.

Volume can be adjusted mid-note; that is, the listener can experience a crescendo or 
diminuendo for a held note. And as with a live choir, the various parts are changing their 
loudness independently, something you cannot do with the stereo’s loudness knob.

Velocity, a term based on how fast a key-
board player hits the keys, controls how 
forcefully the note is sung. Adding force 
changes not only the loudness of the notes, 
but usually also changes the notes’ timbre. 
With a piano’s action, the velocity cannot 
affect what happens to the sound after the 
hammers hit and leave the strings, and ve-
locity works the same way. In the current 
implementation of MIDI, velocity is usually designated by a number between 1 and 127. 
And most software sequencers display velocity as vertical bars, something like the dia-
gram at the right.

Many modern sample players, PLAY included, play different samples for different rang-
es of velocity. For example, the team creating the samples recorded the alto section’s 
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Middle C at pp, p, mp, mf, etc. The team then assigns the pp samples to, say, velocities 
1–25, the p samples to velocities 26–45, and so on. Because each dynamic level of a 
voice has its own timbre, a note’s velocity affects not only its loudness but also its timbre.

Velocity changes are, therefore, a much better way than volume changes to achieve 
natural-sounding dynamics. The disadvantage of velocity is that it cannot be changed 
mid-note. Using the two together gives the orchestrator control over more aspects of the 
dynamics.

In MIDI, velocity is an attribute of the Note-On message; it can only be transmitted at 
the onset of a note. Volume, in contrast, is a control change (CC7); it can be transmit-
ted at any time. Likewise, the parameter called “Expression” is represented by another 
MIDI control change (CC11). In EWQLSC, CC11 is used to control dynamics. It is pos-
sible to shape the dynamics of a line either by “playing” a CC11 controller in real time, 
or by drawing an envelope in a sequencer. Most MIDI keyboards and control surfaces 
have programmable knobs and/or sliders that can be set to send CC11 messages to a 
specific MIDI channel. (Sliders are generally more sensitive for real-time control.) If your 
sequencer supports automation, it can record your movements of the knob or slider and 
save them as part of the project. Such manual control over the shape of a vocal line is 
usually more efficient than drawing in an envelope, and often achieves more convincing 
results.

EastWest’s and Quantum Leap’s choice to use CC11 allows CC7 (volume) to be used in 
other ways. For example, you can use the volume slider in your sequencer to adjust the 
overall volume level of each track in the mix. The ability to do this is especially helpful 
when using more than one mic position. If you want to experiment with how much Close, 
Stage, and Surround mics for a given choral section or soloist to include, record them 
in different audio tracks and then use CC7 to do ad-
just relative overall volumes. CC11 is somewhat in-
dependent of CC7 and can adjust dynamics to shape 
phrases within the tracks. 

Although the volume and expression controls can be 
adjusted separately, the volume setting does change 
how expression affects perceived volume. Think of 
CC7 as setting an upper limit on the dynamics at any 
moment, as in the diagram at the right. Expression, 
like most continuously changeable values in MIDI, 
takes values between 0 and 127. CC7 specifies how loud a sound to generate for the 
maximum CC11 value, 127, and for other CC11 values proportionately. 

MIDI Envelopes and Control Data
Most modern sequencers let you draw an envelope for the most common MIDI control 
codes. The diagram with the light-colored curve at the end of this paragraph is an ex-
ample of an envelope for CC11. Notice how the values are constantly changing, the 
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same way a singer modulates his or her breath and tone to shape the musical line. (The 
horizontal lines near the top are the notes.)

When saved as MIDI data, this same envelope appears as a finite set of commands. In 
a sequencer track, these often appear as vertical lines, each line being a command to 
change the value—in this case to change CC11.

The other way—and many say the better way—to send CC11 events to the sample player 
is with a MIDI controller, either a keyboard or a control surface. As long as you have an 
extra hand—or foot, if you use a pedal—you can enter these control codes while playing 
the notes into the sequencer. This allows you to hear the interchange among the notes, 
their velocities (how hard you’re hitting the keys), and the expression being added with 
CC11.

This process can also be done in two passes—notes first, then control data—if your setup 
allows you to record automation data to a track that already contains other MIDI data.

Everything written about CC11 in this section also applies to CC1 (Mod Wheel) and all 
other MIDI control codes. Learning to shape musical lines the same way a singer does 
will give your work a more natural musicality. By combining velocity control, expression, 
Mod Wheel, and volume, you change digital samples into real, living music.

Release Trails in Symphonic Choirs
The EastWest/Quantum Leap Symphonic Choirs is an ambient library complete with 
release trails for the Stage and Surround samples. (Note that the close C samples do 
not include release trails, partly as a measure to conserve computer resources. A small 
amount of artificial reverb can be added to make them mix appropriately with the other 
samples. And because the close samples are the one with the least natural reverb rela-
tive to the loudness of the sung notes, the lack of release trails on this component should 
not significantly degrade the mix.)

Release trails capture the sound of the hall from the moment the note ends. (As is evident 
in the Time Editor within WordBuilder, Symphonic Choirs includes some of the phonetic 
content of a syllable in the release trails. This is the small but non-zero time it takes the 
singers’ vocal apparatus to close the syllable, and may include the consonant(s) at the 
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end of the syllable.) And the release trails also include the natural sound of each note’s 
decay within the ambient space of the concert hall. The complex and subtle nature of 
the reflected sounds off the walls, ceiling, and other surfaces is nearly impossible to 
generate accurately after-the-fact with an artificial reverb.

The release trail samples are triggered by the MIDI Note-Off event. Their parameters can 
be adjusted in PLAY, or even turned off, if you want.

The release trails are amplitude-matched to the wave form of the playing note, no matter 
where the playback is in the AHSDR envelope when the note ends. The software analyzes 
the amplitude of the note’s waveform at the time of the Note-Off event, then activates 
the release trail, automatically adjusting the release trail amplitude so the two samples 
blend seamlessly. The result is very natural. 

Panning
Panning is not usually necessary. Every section in the library has been recorded in its 
proper place on stage using custom equipment built by recording engineer Prof. Keith O. 
Johnson. The full and surround ambiences reflect the positioning perfectly: sopranos on 
the left down to basses on the right, as on a typical concert hall stage.

The close mics do not reflect the positioning on stage, because they are close to each 
section or soloist. These have been pre-panned in programming to match their true place 
on stage. You will notice that the close mics have panning values and the full and sur-
round mics do not. You can of course, easily change any panning setting, but to do so 
may make less realistic the apparent natural positioning of the singers within the concert 
hall.

The 3 Mic Positions
Much has been written about extra efforts of the East-
West/Quantum Leap team to record all samples from 
three separate microphone positions within the hall: 
both in Symphonic Orchestra and Symphonic Choirs. 
To understand how the three mic positions work, let’s 
perform a quick thought experiment. Imagine your-
self in any large concert hall with an entire a capella 
chorus on the stage. The diagram at the right shows 
the concert hall stage at the top, with the letters indi-
cating the placement of the various mics.

First, you’re invited to sit directly in front of the tenor 
section while they sing their part. What you hear ap-
proximates the sound recorded in the Close mic posi-
tion. The sound coming directly from the singers is so 
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much louder than the reflections off the walls and other surfaces that these reverbera-
tions make up a very small part of what you hear.

Next, you’re placed in a chair at the very front of the stage—or maybe the front row of 
the house—and you listen to the same tenor melody. Now you hear more of the natural 
reverberation of the hall because your ears are not so overpowered by the sound coming 
directly from the chorus. This sound is captured by the Stage mics (also called Far mics, 
hence the F in the diagram), a cluster of microphones near the front of the stage.

Finally, you’re asked to sit nearer the back of the house and high up, maybe in the 
middle of the Balcony. The same tenor melody is played. From this perspective, the 
full acoustics of the hall are most evident because you hear clearly the sound bouncing 
off the ceiling, the walls, all the reflective surfaces, in front of you and even behind. It 
can be a very lush sound, though perhaps lacking in the immediacy of a closer position; 
however, adding in a little of this sound (either in a stereo mix or in the rear speakers of 
a surround-sound recording) can add dimension to the recording. This mic position was 
used to create the Surround samples.

This is the first choral sample library to include user control of three simultaneous stereo 
microphone setups (Close, Stage and Surround) for the soloists and sections. You can 
mix together any combination of these microphone positions to control tone and ambi-
ence. It’s like virtually repositioning the listener by incrementally moving out from the 
close mics, to the stage mics, to the hall mics (known as audio zoom), all in real-time!

Note that the several choirs available in the optional Choirs Expansion are built on 
samples from an earlier library called Voices of the Apocalypse (VOTA). These voice types 
were recorded only with mics that correspond to the Stage mics, those near the front row 
of the audience. Therefore this text about the 3 mic positions does not apply to those 
choirs: Angels, Demons, and Frankenchoirs.

All three sets of samples were recorded simultaneously for each note in the library. 
Therefore, there are predictable and natural delays in the time it take the music to reach 
the further mics. This latency is part of the natural reverb of the hall and produces a 
pleasing fullness to the sound when the samples are mixed. If you want to tighten up the 
reverb from the S samples, it is possible with modern sequencers and mixers to adjust 
the audio track from the S samples a little forward in time. Either perform a calculation 
using the speed of sound at sea level (approximately 340 meters/second; 1100 feet/
second, if you prefer) or let your ears decide what works best.

The close mics, of course, have virtually no latency: only a small amount necessary to 
retain the sonic perspective of the choirs in the concert hall. If you don’t use the close 
mics, and you play something that requires very quick and punchy attacks, you may no-
tice some small delay, which can be cured by adding in some of the close mics. In most 
cases you would want to use the close mics to add definition to a section. The idea is to 
experiment until you find a combination that works.
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During sampling, the simultaneous recordings from all three positions were phase-locked. 
This attention to detail ensures that the samples can be bounced down to a single audio 
track without introducing phasing problems.

Many composers still work in stereo only. You can mix all three ambiences together with-
out any phasing issues. You will actually hear a lot of dimension in your stereo mixes. 
Consider this: if you render a close mix, a full mix, and a surround mix of every piece you 
write, you will have an archive that can be used to create surround mixes in the future. 
And you know it will work—perfectly! This technique also allows you to do quick wetter 
or drier remixes in the future.

Controlling Ambiance with the 3 Mics
Controlling the natural reverberation of the concert hall can 
be as easy as adjusting the level of Surround mics, and turn-
ing on or off the Close mics. If you require more control, the 
volume of the release trails can be altered in the Articulations 
control. The image at the right shows the level of the release 
trails lowered by 2.5 dB relative to their original loudness. Just be sure to make the same 
adjustment in all the 6 to 12 instrument files when you load a multi.

Some Sound Advice
Generally, in our opinion, the Stage mic has the best overall sound if you will be using 
only one mic position, but a combination of the three mics usually creates the most 
impressive sound. Although it may vary with the type of choral music being recorded, 
the sections often sound best with the Close  mics turned down in volume (leaving only 
enough of the close mics to add definition).

Try this: Boost the Close mics up to 6db (bell shape with a fairly wide Q) between 5K and 
10K. Then roll off the frequencies below 800Hz so you are down about 10db at 50Hz. 
Then mix the Close track into the Stage track at a low volume to add clarity and sheen 
to the stage mics. (Be careful not to use too much of the close mics with this EQ curve.) 
Other styles may sound just right using an equal blend of all ambiences. The idea is to 
experiment until you find a combination that works.

Various Ways to Combine the Samples
Using Close and Surround Mics Sparingly
One possible approach when using EWQLSC to create a stereo mix is to use primarily the 
Stage mics and then blend in just enough of the Close samples to provide more imme-
diacy, plus enough of the Surround samples to create a more natural reverb to the overall 
sound. There’s no reason to keep the mix constant for the duration of the piece. Maybe 
you’ll want to add in a little extra Close mics to a section that has the most important 
lyrics at the moment. Or give the altos the extra punch to stand out when they carry the 
melody, or push up the Surround perspective to make the chorus of townspeople sound 
more distant when they first arrive on the scene. Use your ear and your imagination to 
find the best mix for both you and the piece you’re working on.
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Blending All Three Mics
Another approach is to create three mixes of a piece that are identical except that they 
were “played” with the three separate sets of samples. Each of the three “takes” (Close, 
Stage, and Surround) is bounced down to a stereo track. In a final bounce-down, the 
volume levels of the three perspectives are adjusted to achieve a single track with the 
desired sound. This approach can generate either stereo tracks or any of the surround 
sound formats (4.0, 5.1, LCR+LFE, Matrix UHJ, and many others). More on surround 
sound can be found on page 92.

Go for the Intimate—or the Expansive—Sound
Note that some musical styles can benefit from using the Close or Surround sound as the 
starting point. A recording of a Renaissance motet—or other chamber ensemble—might 
benefit from the sound of using mostly the Close samples. And a dreamy or mysterious 
film score might be more effective when based on the Surround samples. Such decisions 
may also apply with religious music, or if you are looking for a “Lord of the Rings” type 
of sound. Let your ears decide.

Beyond the Panning Controls
All EWQLSC voices take their traditional position on the concert hall stage. And the pan-
ning position is reinforced by tiny differences in the arrival of sounds to the left and right 
mics. Not only do the sounds directly from the different sections have different arrival 
times, but so also do the reverberations from the left and right walls. This is true, though, 
only for the Stage and Surround mics on the center line of the concert hall; for the Close 
mics, any difference in timing is imperceptible.

To fit properly in the soundscape, the Close samples are programmatically panned left 
or right to simulate their respective positions on the stage (you can see that in the PLAY 
interface). But panning only affects relative volume of the two channels.

If you want to pin down perceived location even more strongly when using the Close mics, 
it’s possible to time-adjust the left and right channels separately to move the singers 
where you want them. To reinforce panning the listener’s left, first remember that the 
direct sound in the C mics is stronger than the natural reverb. Therefore, take its EQ’ed 
left channel audio and move it earlier a few milliseconds; this will simulate the instru-
ment’s sound arriving at the left mic first. Also, move its EQ’ed right channel later, as if 
it took longer for the sound to get to the right microphone. Reverse those directions to 
pan the sound to the right.

Surround Sound Samples
Stereo Mixing
When using the Surround samples for two-channel mixes, adding in a little of the lush 
sound of the S mics can convincingly convey the feeling of a live recording in a concert 
hall: well, at least as much as any stereo recording can do that. If you want a realistic 
concert hall sound, do not over-add the Surround samples; a little in the mix may be all 
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you need. Those looking for other types of recordings (film scores, audio tracks for games, 
etc.) should feel free to experiment.

Surround Sound Mixing
This discussion focuses on the most popular format, 5.1, but the guiding principles ap-
ply to other standards as well.

Here’s a starting point for creating the 6 channels you need to create a 5.1 recording. 
Feel free to experiment with variations.

Front Center: Take either the left or right signal from the stereo Close mics—but not both 
left and right. Use this to create the immediacy needed for the front center.

Front Left & Right: The Stage mics (left and right) are assigned to the front speakers (left 
and right). Add in a little of the Surround mics here for a lusher overall sound.

Rear Left & Right: The two rear channels accept input from the two stereo Surround mics 
exclusively. Use your judgment about how much signal to send here, based on the type 
of recording you’re creating.

LFE: Unless you’re creating a mix for a hardware environment with a discreet LFE chan-
nel, the system that plays your music can best determine its own crossover frequency 
between the sub-woofer and the other channels based on the characteristics of the hard-
ware. Therefore, none of the music from the EWQL libraries should be added to the LFE 
channel. Only non-musical effects, such as explosions and dinosaur footsteps, should 
be added to this track directly. Note that this is a change from earlier advice about sur-
round sound mixing.

If you are writing for specific hardware that does not provide its own crossover, then use 
the older advice, as follows. The low frequency and effects channel should be pulled 
from a mix of all the other channels; that is, the relative volume of the various mics 
(including any time delays and EQ applied separately to discreet channels) should be 
proportionally applied to the LFE channel. Be sure you use a crossover filter that removes 
from the other 5 channels the exact same range of frequencies added to the LFE. Not 
excluding the low-frequency sounds from the other channels results in inappropriate 
doubling of those frequencies.
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The Phonetic Alphabets

How WordBuilder Uses Phonetics
This chapter of the manual compares the various phonetic alphabets available with 
WordBuilder. It also provides examples of English words that use them to assist the 
reader in understanding the sound each symbol represents.

The sounds in WordBuilder and Symphonic Choirs are based on the sound of natural 
speech, not the way words are spelled on a page. Therefore, WordBuilder uses a pho-
netic alphabet to notate the sounds that will be sung. The Votox phonetic alphabet was 
designed specifically for the task of representing the sound of sung words. This chapter 
presents what you need to know about Votox to help you get the most out of WordBuilder.

Lists of The Phonetic Symbols
The tables on the next few pages list the symbols from the Phonetics alphabet and com-
pare each one to the corresponding Votox symbol. Two English words are provided to give 
examples of each symbol’s sound.

There are two table because WordBuilder provides two sets of Votox symbols that differ 
only in their vowels. In the Options dialog box, the user has a choice between “English 
Mode” and “Latin Mode” (see page 74). The choice does not affect the sounds, only the 
symbols used to represent those sounds in Votox. Speakers of Romance languages may 
feel more comfortable using Votox in Latin Mode, as the symbols more closely reflect 
spellings in Romance languages. English speakers will most likely prefer the English 
symbols. In the Vowel Comparison table below, read aloud each of the words in the right-
most column and decide which of the vowels to the left seems more natural to you. Then 
work in the mode (i.e., the column) that most often felt more correct.

Here are two tables that compares the two sets of Votox vowels. First, the table of simple 
vowels. Note that in the first three rows, the English and Latin versions of the vowels of 
the same.
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VOTOX VOWEL COMPARISON
English Mode Latin Mode Example English words

a a money, rough

e e red, steady

o o orange, naughty

u A money, rough

A a! black, after

E i index, finger

i E never used alone, only in diphthongs

O u pool, blue

And here is the table of diphthongs, the sounds made up of two vowels sounds in a row:

VOTOX VOWEL COMPARISON
English Mode Latin Mode Example English words

aE ai white, sigh

uO Au brown, mouse

iE Ei gray, slate

EE ii green, ski

oE oi oil, boy

oO ou yellow, ocean

ur Ar purple, lower

Because of the close relationship between the symbols of the Phonetics and Votox “al-
phabets,” you should only need to learn one. The EWQLSC team recommends always us-
ing Votox, sounding out the words to achieve the desired sound. Use the other two modes 
to help you learn Votox, but once mastered, Votox gives you more direct control because 
you’re working in the same alphabet as WordBuilder, with no conversion necessary.

The tables are on the next two pages, positioned one per page, in case you want to want 
to print out a page to use as a reference guide while you learn your phonetic alphabet of 
choice.
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Phonetic Alphabet with English Vowels

PHONETIC ALPHABETS: WITH ENGLISH VOWELS
Phonetics Votox Phonetics Votox

a u money, rough m m money, hammer

a! a copper, wander n n green, snug

Ai aE white, sigh o o orange, naughty

Au uO brown, mouse Oi oE oil, boy

b b blue, slab Ou oO yellow, ocean

c! C! chair, catch p P pink, upper

d d red, candor r r red, car

d! t! the, neither r! ur purple, lower

e e red, steady s S silver, lace

e! A black, after t T white, true

Ei iE grey, slate t! T! theme, sloth

f F file, enough u U put, could

g g green, leg u! O blue, pool

g! ng ping, hangar v v olive, avert

h H hat, ahead w w wait, awash

i E index, finger x X fix, excess

i! EE green, ski x! S! flesh, nation

j j orange, fidget y y yellow, yonder

k K black, coal z z zero, poison

l l blue, less z! zj vision, azure
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Phonetic Alphabet with Latin Vowels

PHONETIC ALPHABETS: WITH LATIN VOWELS
Phonetics Votox Phonetics Votox

a A money, rough m m money, hammer

a! a copper, wander n n green, snug

Ai ai white, sigh o o orange, naughty

Au Au brown, mouse Oi oi oil, boy

b b blue, slab Ou ou yellow, ocean

c! C! chair, catch p P pink, upper

d d red, candor r r red, car

d! t! the, neither r! Ar purple, lower

e e red, steady s S silver, lace

e! a! black, after t T white, true

Ei Ei grey, slate t! T! theme, sloth

f F file, enough u U put, could

g g green, leg u! u blue, pool

g! ng ping, hangar v v olive, avert

h H hat, ahead w w wait, awash

i i index, finger x X fix, excess

i! ii green, ski x! S! flesh, nation

j j orange, fidget y y yellow, yonder

k K black, coal z z zero, poison

l l blue, less z! zj vision, azure
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Instruments, Articulations, and Keyswitches
EastWest/Quantum Leap Symphonic Choirs, consists of both the standard Choirs product  
and an optional Expansion product. This version of the manual does not include informa-
tion about the Expansion patches. If you have bought the Expansion product, check for 
a separate manual on its DVD.

Using the Choir Patches
This first part of the chapter deals only with choir “instruments,” that is, the sounds of 
multiple people singing together in unison, not those of the soloists. For details of how 
to use the solo “instruments,” see that section of the manual, starting on page 105.

These choir patches fall into the following categories:
•	 5 voice types in a traditional choir (sopranos, altos, tenors, basses) plus boy sopranos
•	 2 voice types that combine sopranos and altos into a women’s voice, plus tenors and 

basses into a men’s voice, to provide a wider range on a single voice type

All seven of these voice types are found with the Browser in the Multis folder. A multi-
instrument—to use the full name—is a means for loading more than one instrument file 
with a single click of “Add” or “Replace” in the Browser.

Using Multis with WordBuilder
To accommodate the large number of separate phonetic sounds associated with each 
note of the scale, a single section, for example, the Alto section, uses 6 instrument files 
in a single collection known as a multi. Certain rules must be followed to let the Word-
Builder software work properly, with this collection of related “instruments,” but PLAY 
and WordBuilder set up most of what you need automatically.

The Choirs “instruments” are divided 
into Instruments and Multis in the 
browser, as in the screen shot at the 
right. Those in the folder called Multis 
all load more than one instrument (.ewi 
file) into PLAY and assign each instrument a unique channel number (usually from 1 to 
6, sometimes from 1 to 12). After loading one of these multis into PLAY, if you look in 
the Instrument drop-down list (in the upper right corner of the PLAY window), you will 
see that either 6 or 12 instruments have been loaded for you, as in the image at the left. 
(By the way, if you have not already changed the setting to Auto-Increment MIDI Chan-
nels in the Settings dialog box, you should probably do so; otherwise you may have to 
assign the separate channels to all 6 (or even 12) instruments individually.
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The loaded multi must match the voice type specified in 
WordBuilder. For example, if you load an Altos multi, you 
must also set the instance of WordBuilder to Altos and, in 
standalone mode, make sure that the output port in Word-
Builder for the Altos exactly matches all 6 (or 12) input 

ports in PLAY for the Altos multis.

Following these rules guarantees that when you request a “z” sound on the note E3, 
that’s what you get.

Like most other instruments in the EastWest PLAY System libraries, the choirs do con-
tain multiple articulations. Each of the multis (except Boy Sopranos) provides a choice 
among 4 separate articulations:

•	 normal: a natural attack
•	 legato: a fast, smooth attack
•	 staccato: short, level-3 velocity
•	 slurred: subtle and quick sliding up to the pitch

These articulations are selected in the WordBuilder UI and, therefore, they are described 
in the chapter call Using WordBuilder, in a section called Controlling Segment Transi-
tions with Articulations, starting on page 47.

The Boy Soprano multis contain only 2 articulations:
•	 normal: a natural attack
•	 legato: a fast, smooth attack

The Multis in Symphonic Choirs
The following tables list the names of the multis and a brief description of their sounds. 
The names that include HARD MOD, SOFT MOD, and DYN MOD warrant further explana-
tion than what fits in the tables:
•	 DYN MOD multis are a 3-way dynamic cross-fade: soft through medium to hard, with 

more detail in the two items directly below.
•	 HARD MOD multis are a 2-way dynamic cross-fade between medium volume, medium 

vibrato samples and loud, heavy vibrato samples; the loudest two-thirds of the DYN 
MOD patch.

•	 SOFT MOD multis are a 2-way dynamic cross-fade between soft volume, non-vibrato 
samples and medium volume, medium vibrato samples; the softest two-thirds of the 
DYN MOD patch.



EAST/WEST QUANTUM LEAP SYMPHONIC CHOIRS VIRTUAL INSTRUMENT

  101Chapter 10: Instruments, Articulations, and Keyswitches

SOPRANOS
SOPR WB DYN MOD 3-way Mod Wheel cross-fade

SOPR WB HARD MOD 2-way vibrato Mod Wheel cross-fade

SOPR WB SOFT MOD 2-way non-vibrato/vibrato Mod Wheel cross-fade

SOPR WB NV non-vibrato

SOPR WB VBF vibrato, forte

SOPR WB VBM vibrato, medium

ALTOS
ALTO WB DYN MOD 3-way Mod Wheel cross-fade

ALTO WB HARD MOD 2-way vibrato Mod Wheel cross-fade

ALTO WB SOFT MOD 2-way non-vibrato/vibrato Mod Wheel cross-fade

ALTO WB NV non-vibrato

ALTO WB VBF vibrato, forte

ALTO WB VBM vibrato, medium
 

TENORS
TENR WB DYN MOD 3-way Mod Wheel cross-fade

TENR WB HARD MOD 2-way vibrato Mod Wheel cross-fade

TENR WB SOFT MOD 2-way non-vibrato/vibrato Mod Wheel cross-fade

TENR WB NV non-vibrato

TENR WB VBF vibrato, forte

TENR WB VBM vibrato, medium

BASSES
BASS WB DYN MOD 3-way Mod Wheel cross-fade

BASS WB HARD MOD 2-way vibrato Mod Wheel cross-fade

BASS WB SOFT MOD 2-way non-vibrato/vibrato Mod Wheel cross-fade

BASS WB NV non-vibrato

BASS WB VBF vibrato, forte

BASS WB VBM vibrato, medium
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BOYS
BOYS WB DYN MOD 2-way non-vibrato cross-fade

BOYS WB HARD non-vibrato, forte

BOYS WB SOFT non-vibrato, piano

Full Men’s and Full Women’s Choruses
Symphonic Choirs creates a voice type known as “Women” by using the Altos samples 
for the lower half of the range and Sopranos samples for the upper half. If you load this 
voice type in WordBuilder and PLAY, you have a single voice that can sing notes over a 
range of F2 to E5, almost 3 octaves.

Likewise, a voice type of “Men” combines Bass and Tenor samples to create a voice that 
covers the notes from B0 to D4, more than 3 octaves.

As you might expect, there is a somewhat discernible change in timbre at the point near 
the middle of the range where the underlying voice type changes, so evaluate whether 
this will be a problem for your project before deciding to use either Men or Women as a 
voice type.

EastWest achieves this wider range by using 12 MIDI channels (instead of the 6 chan-
nels for the other voice types). And note that Men and Women use special, range-restrict-
ed versions of the instruments for Sopranos, Altos, Tenors, and Basses. This small range 
makes sure that each note in the Men’s voice type plays either a Tenor sample or a Bass 
sample, but not both.

Memory Considerations When Choosing Multis
Note that the “DYN MOD” multis use a lot of memory and, therefore, require a high-
powered computer. Use other multis when dynamic cross-fading from the softest to the 
loudest is not crucial or when the computer’s power and/or memory is too low to handle 
so many samples at once. 

The Component Programs
The multis listed in the previous section are designed to be used only with WordBuilder; 
you should not load any one of them into PLAY and call it from a sequencer directly. If 
you try that, you will get unpredictable 
results. Instead, EWQLSC provides in-
dividual “instrument” files that you can 
open in PLAY to hear any single pho-
netic components directly. These files 
are documented below.

The “Instrument” files for the four adult choirs—Soprano, Alto, Tenor, Bass—all have the 
same patterns of consonants, vowels, and vocal effects. To save space, only the bass ar-
ticulation files are listed below. The others use “TENR,” “ALTO,” “SOPR” in their names.
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The first group listed is vowels. These are all dynamic cross-fades. The keyswitches pro-
vide access to the same four articulations available through WordBuilder:

KEYSWITCHES
Articulations Keyswitches

normal C0

legato C#0

staccato D0

slurred, sliding D#0

The table below lists the vowels and some example English words that use those sounds. 
The third column provides the Votox equivalent.

VOWELS
File names Sample words Votox

BASS uh DXF C0-D#0 money, rough u

BASS ee DXF C0-D#0 green, ski E

BASS oo DXF C0-D#0 blue, pool O

BASS ih DXF C0-D#0 index, finger i

BASS eh DXF C0-D#0 red, steady e

BASS oh DXF C0-D#0 yellow, ocean o

BASS eu DXF C0-D#0 put, could U

BASS ah DXF C0-D#0 copper, wander a

Note that none of the effects listed below is available in WordBuilder. To generate one, 
you have to load the individual file listed here directly into PLAY.

EFFECTS
File names Description of the effects

BASS cluster oh The voices sing notes close in pitch but not the same

BASS whiswords Each MIDI note is a different unpitched, whispered word

BASS ahiheh A slowly evolving sound through 3 vowels: ah, ih, eh

BASS falls A held note with falling pitch

BASS cluster fx Clustered slides, evolving shouts, etc.

BASS eeoheh A slowly evolving sound through 3 vowels: ee, oh, eh

BASS shouts Various short, unpitched shouted vowels

The whispered words are real words, such as “blood,” “dream,” “evil,” “silence,” and 
“Hallelujah!”
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CONSONANTS
File names Sample words

BASS b blue, slab

BASS d red, candor

BASS g green, leg

BASS j orange, fidget

BASS l blue, less

BASS m money, hammer

BASS n green, snug

BASS r red, car

BASS rr a “rolling R”

BASS th the, nether

BASS v olive, avert

BASS w wait, awash

BASS y yellow, yonder

BASS z zero, poison

BASS non-pitched see table below

The non-pitched consonants are those that carry no breath; in linguistic theory they are 
called “unvoiced.” The following table enumerates them. Because they have no pitch, 
only a single note is required to play any one of these consonants, and those note names 
are listed in the table. (The meaning of note names can vary with implementation; here 
C4 is MIDI note 72, one octave above Middle C.)

NON-PITCHED CONSONANTS
Consonants Sample words Notes

ch chair, catch C4

f file, enough C#4

h hat, ahead D4

k black, coal D#4

p pink, upper E4

q quick, acquaint F4

s silver, lace F#4

sh flesh, nation G4

t white, true G#4

th theme, sloth A4

x fix, excess A#4
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The individual “instrument” files for the boys choir are similar, but not exactly the same. 
Here’s how they differ.

The vowels have only two notes used as keyswitches. Therefore, all the file names end 
in “C0-C#0” to indicate that. Use the C0 (MIDI note 24) for Normal Attack and C#0 for 
Legato. In every other way, the same 8 cross-faded program files exist for the boys choir 
samples.

The Boy Sopranos’ vocal effects are a different list than for the adults. See the following 
table.

The consonants are identical to those of the adult choirs.

The sample set includes the following four vocal effects for the boys choir.

EFFECTS
File name Description of the effects

BOYS cluster Pitch-clusters on various vowels and M- and N-sounds

BOYS ah staccato The “ah” syllable sung staccato

BOYS oh slur DXF The “oh” syllable with a small upward slide at the start

BOYS shouts Various group shouts

The Soloist Samples
This section deals only with soloist samples, not those of the choir. For details of how to 
use the choir samples, see that section of the manual, starting on page 99.

The soloist samples are not designed to work with WordBuilder. Instead they are provided 
as expressive voices. Such usage is common in film scores and ambient music.

Three soloist voices are provided:
•	 Soprano
•	 Alto
•	 Boy Soprano

There is no Tenor or Bass soloist because those solo voices are less popular and rarely 
appear in film scores.

Each of these three voices is provided as a keyswitched articulation file.

SOLOISTS
SOP Solo KS C0-F#0

ALTO Solo KS C0-A#0

BOY Solo KS C0-A0



EAST/WEST QUANTUM LEAP SYMPHONIC CHOIRS VIRTUAL INSTRUMENT

  106Chapter 10: Instruments, Articulations, and Keyswitches

Soloist Files
Each of the soloist files uses keyswitches to control the syllable that is sung and the style 
of singing. The following tables describe the effect of each keyswitch.

SOPRANO SOLO KS C0-F#0
Keyswitch note Sound Description

C0 ah Non-vibrato

C#0 ah Expressive, vibrato

D0 mm Expressive, vibrato

D#0 oh Non-vibrato

E0 oh Expressive, vibrato

F0 oo Non-vibrato

F#0 oo Expressive, vibrato

ALTO SOLO KS C0-A#0
Keyswitch note Sound Description

C0 ah Expressive, vibrato

C#0 ah Non-vibrato

D0 ah Expressive, vibrato slur

D#0 oh Expressive, vibrato slur

E0 ee Expressive, vibrato

F0 mm Expressive, vibrato

F#0 oh Expressive, vibrato

G0 oh Non-vibrato

G#0 oh Expressive, vibrato 2

A0 oo Non-vibrato

A#0 oo Expressive, vibrato
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BOY SOLO KS C0-A0
Keyswitch note Sound Description

C0 oh 2 boys, non-vibrato

C#0 ah Non-vibrato

D0 ah Slurred up, non-vibrato

D#0 oh Non-vibrato

E0 oh Slurred up, non-vibrato

F0 oo Non-vibrato

F#0 Random syllables

G0 Random syllables

G#0 Random syllables

A0 Random syllables

The last 4 keyswitches for the boy soloist generate common Latin syllables. Stringing 
these together on a melody makes it sound as if the boy is singing words in Latin or some 
language the user does not understand. You have 4 syllables to choose from for each 
note in the melody.

As an example, play the lowest B in the boy soprano’s range four times, and precede 
each note, in turn, with the keyswitches A0, G#0, G0, and F#0. That creates the text 

“noo-mah-nah-fee.”
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EASTWEST/QUANTUM LEAP LICENSE AGREEMENT

EASTWEST END USER LICENSE AGREEMENT:  Please read the terms of the following 
audio samples License Agreement before using these audio samples. By opening the 
packaging and installing these audio samples, you agree to become bound by the terms 
of the License Agreement. If you do not agree with the terms of the License Agreement, 
do not open the packaging or use these audio samples. East West Sounds, Inc. (“Licen-
sor”) guarantees that all of the samples with these discs have been created and record-
ed specially for this project, and any similarity to any other recording is unintentional. 
1. The audio samples recorded with these discs remain the property of Licensor and are 
licensed, not sold, to you for use with your sampling software or equipment. 2. A right to 
use the enclosed sounds is granted to the original end-user of the product (Licensee) and 
is NOT transferable. 3. The Licensee may modify the sounds. LICENSEE MAY USE THE 
SOUNDS FOR COMMERCIAL PURPOSES WITHIN MUSICAL COMPOSITIONS. 4. The 
following terms apply to the use of loops (compositions that contain a combination of 
sound samples that can be repeated to form a continuous piece of music) used in ‘music 
or production libraries’ that are relicensed to multiple third parties. (1) Loops must be 
used in a musical context with at least two other instruments that contribute significantly 
to the composition. (2) The entire loop cannot be left exposed at any time in the com-
position. (3) If you have any doubts a composition meets this criteria, you may submit it 
to licensing@eastwestsounds.com for written approval. Please do not send audio or MP3 
files, send us a link to your composition on your web server. 5. This license expressly 
forbids resale, relicensing or other distribution of these sounds, either as they exist 
on these discs, or any modification thereof.  You cannot sell, loan, rent, lease, assign, 
upload to or download from any server, or transfer all or any of the enclosed sounds to 
another user, or for use in any competitive product. 6. Licensor will not be responsible 
if the contents of these discs does not fit the particular purpose of the Licensee. If in 
doubt over usage, please contact East West Sounds, Inc. by fax: (USA) 323-957-6966 
or email: licensing@eastwestsounds.com. ALL RIGHTS RESERVED. ©2007 EAST WEST 
SOUNDS,	INC.		•		Windows	XP/Vista	are	registered	trademarks	of	Microsoft	Corporation.	
Pentium is a registered trademark of Intel. VST Instruments is a registered trademark 
of Steinberg Media technologies AG. OS X, Audio Units and Core Audio are registered 
trademarks of Apple, Inc. All other product and company names are trademarks of their 
respective holders. All specifications are subject to change without notice.
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